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1. INTRODUCTION

1.1Purpose and Scope

This document describes methods utilized and procedures used to perform a software upgrade of Oracle
Communications Policy Management Release 12.2.x to Release 12.3 when georedundancy is enabled.

e Upgrade of firmware is required, but is not covered in this document.

Georedundancy as implemented in the MPE and the MRA uses the 2+1 server cluster scheme. The 2 refers
to the current Active and Standby servers and the +1 refers to a third Spare server. The Spare server is
added into the same cluster so that any server can assume the Active role if necessary. The Spare server is
usually located in a separate geographical location in case the servers at the initial site become unavailable
due to a site-wide failure. The Spare server, in most cases, is unaffected by the same circumstances and is
able to continue to provide service as an Active server.

1.2Acronyms
Acronym Definition
CMP Configuration Management Platform
Configuration Management Platform for Disaster Recovery
DR-CMP
NOTE: It refers to the CMP on the secondary site
DSR Diameter Signaling Router
GUI Graphical User Interface
IPM Initial Product Manufacture
LVM Logical Volume Manager
MPE Multimedia Policy Engine
MPE-LI MPE for Lawful Intercept - a type of Multimedia Policy Engine
MRA Multiprotocol Routing Agent (also known as the Policy Front End or PFE)
0Cs Online Charging System
00s Out of Service
PCEF Policy Control Enforcement Function
PCRF Policy and Charging Rules Function—Oracle MPE
PM&C Platform Management and Configuration
TPD Tekelec Platform Distribution
TVOE Tekelec Virtual Operating Environment
UE User Equipment

6 E85338-01
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1.3Terminology
Term Definition

Primary Site (Sitel) Site where the MPE/MRA/Mediation Server-A and Server-B are deployed.

Secondary Site (Site2) Site where the MPE/MRA/MA/Mediation Server-C is deployed.

Spare Server or Server-C Server that is ready to take over from the Active server if both the Active and
Standby servers fail. It is generally in a different location than the Active and
Standby servers.

Segment A segment is a collection of HSGWs, P-GWs, DSRs, MPEs and MRAs that provide
the PCRF service. A single MPE/MRA cluster can be part of only one PCRF
Segment. A CMP manages all the MPE/MRAs at multiple sites. A CMP manages
one or more PCRF Segments.

1.4 Software Release Numbering

Firmware

Oracle: 3.1.5

HP Solutions Firmware Upgrade Pack: 2.2.9 or higher
COMCOL: 6.4

PM&C: 6.0.3

TPD:7.0.3

TVOE: 3.0.3

Policy Management release 12.3

E85338-01




Software Upgrade Procedure

2. UPGRADE OVERVIEW

This section lists the required materials and information needed to perform Policy Management release
12.3 software upgrades.

2.1Upgrade Status Values

Status Condition
OK All servers are up-to-date and no alarms are present.
Info No alarms are present, but a condition (such as out-of-date) is present that the

operator should be made aware of.

Minor At least one minor alarm is present.

Major At least one major alarm is present.

Offline The server cannot be reached.

Degraded At least one server in the cluster cannot be reached.

Critical At least one critical alarm is present.

Active The server is active.

Standby The server is in standby mode as part of normal operations.

Forced Standby The server is in standby mode because it has been placed into that state via

direct operator intervention or as part of the upgrade.

Offline The server cannot be reached.

Zombie The server is in a state where it cannot recover automatically and requires direct
operator intervention.

2.2Upgrade Paths

This upgrade document supports the following upgrade paths:
1. Policy Management 12.2.xto 12.3
2. Policy Management 12.1.xto 12.3

2.3Upgrade Information

This procedure applies to Active, Standby, and Spare servers. A group of servers is referred to as a cluster.
The cluster types are CMP, MRA, MPE or MA:

e For a CMP cluster, there are only 2 servers (Active and Standby) in a cluster and the cluster is either
a Primary or Secondary cluster.

e For anon-CMP cluster (MRA/MPE/Mediation), there can be 3 servers (Active, Standby, and Spare).

A Policy Management deployment can consist of multiple clusters.

2.3.1 Required Cluster Upgrade Sequence

Policy Server software upgrades are performed on a cluster by cluster basis at the local and remote sites
within the same maintenance window.

8 E85338-01



Software Upgrade Procedure
The following is the upgrade sequence, specific process are documented by an Oracle provided
Maintenance Operation Procedure (MOP).

NOTE: TVOE, PM&C Server, and Firmware may be necessary prior to the Policy Management upgrade.
1. Upgrade PM&C Server at Site 1—Needed if version is older than what is listed in Section 1.4

Upgrade PM&C Server at Site 2—Needed if version is older than what is listed in Section 1.4

Firmware upgrade—If needed (not covered in this document)

Upgrade Primary CMP

Upgrade Secondary CMP (if applicable)

Site 1 Segment 1—Upgrade non-CMP clusters (see note below)

Site 2 Segment 1—Upgrade non-CMP clusters (see note below)

©® N o v kA W N

Site 1 Segment 2—Upgrade non-CMP clusters (see note below)
9. Site 2 Segment 2—Upgrade non-CMP clusters (see note below)

NOTE: Up to 4 non-CMP clusters can be upgraded in parallel.

2.3.2 Policy Release Mixed-Version Operation and Limitation

The general expectation is that a system that is running in a mixed version configuration should support
features, and perform at a level of the previous version. Thus, the system that is running pre-12.3 release
and release 12.3 mixed configuration would support the performance and capacity of pre-12.3 release. The
mixed version Policy Management configuration would support pre-12.3 release features.

Since the CMP is the first Policy Management system component that is upgraded to the new version, the
release 12.3 CMP is managing servers in both the previous release and release 12.3. In this mixed version,
configuration release 12.3 CMP does not prevent an operator from configuring anything that you could
configure in a previous release and all configuration items from the previous release are still available.
However, the configuration changes during the upgrade of Policy Management system are discouraged and
have limited support.

In the mixed version Policy Management configuration release 12.3 CMP has the following limitations while
running in a mixed version environment:

e New features must not be enabled until the upgrades of all servers managed by that CMP are
completed. This also applies to using policy rules that include new conditions and actions
introduced in the release.

e As ageneral guideline, policy rules should not be changed while running in a mixed version
environment. If it is necessary to make changes to the policy rules while running in a mixed version
environment changes that do not utilize new conditions and actions for the release could be
installed, but should be jointly reviewed by the customer and Oracle before deployment to verify
that these policies indeed do not use new conditions or actions.

e The support for configuration of MPE/MRA/MA servers is limited to parameters that are available
in the previous version. Specifically, Network Elements can be added.

9 E85338-01
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Table 1 Mixed-version configurations supported

Policy Management system
components on CMP R12.3 MRA R12.3 MPE R12.3 MA R12.3
CMP 12.2.x Yes No No No
MRA 12.2.x Yes Yes Yes N/A
MPE 12.2.x Yes Yes Yes Yes
MA 12.2.x Yes N/A Yes Yes

NOTE: Replication between CMP and DR-CMP is automatically disabled during upgrade of the CMP and DR-
CMP from the previous release to release 12.3. The replication is automatically enabled once both active
CMP and DR-CMP are upgraded to release 12.3.

2.4 Customer Impacts

The cluster upgrade proceeds by upgrading the standby server, then the spare server, and then switching
over from the active to the standby, and upgrading the new standby. The switchover of each non-CMP
cluster has a small impact on traffic being processed at that cluster.

2.5 Rollback/Backout

The full pre-upgrade server image is stored on the server during the upgrade, and can be restored in the
event of a problem during or after upgrade.

2.6 TPD Version

The Tekelec Platform Distribution (TPD) version needed for this release is included in the Policy Application
Software Upgrade I1SO, and the TPD is upgraded to version 7.0.3 as part of this procedure.

In the case of an initial product manufacture (IPM) or clean install of a new server, the supported baseline
TPD version 7.0.3 should be installed prior to upgrading to Policy Management release 12.3.

2.7 Server Hardware Platforms

The Policy Management release 12.3 software upgrade can be applied on any server that previously had
Policy Management release 12.2.x.

2.8 Loading Application Software

For upgrade of server application software, the recommended method is to copy the application ISO
images to the servers using the scp or ftp command. If the system is HP c-Class using a PM&C Server, the
application software must also be loaded into the PM&C software management library to support new
installs and FRU activities.

NOTE: PM&C is not used during the upgrade and backout procedures.

2.9 Required Materials and Remote Access

The following materials and information are needed to perform an upgrade:
1. Policy 12.3 software ISO files and TPD software I1SO
2. Policy 12.3 software Release Notes.

3. TVOE, PM&C upgrade/installation documentation, software 1SO files and TPD ISO (if applicable).

10 E85338-01
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4. HP Solutions Firmware Upgrade Pack 2.2.9 (or higher) documentation and ISO files (if applicable).

5. The capability to remotely login to the target server as admusr.

NOTE: The remote login can be done through SSH, local console, or iLO maintenance port. Ensure
the customer network firewall policy allows the required application and corresponded ports.

6. The capability to secure copy (scp) from the local workstation being used to perform this upgrade
to the target server, or otherwise be able to transfer binary files to the target server.

7. User login IDs, passwords, IP addresses, and other administration information.
8. VPN access to your network is required if that is the only method for remotely logging into the
target servers. It must be also possible to access the Policy Manager GUI, and the PM&C GUI.

2.9.1 Upgrade Media
See the release notes for the list of ISO image files required for the Policy Management upgrade you are
installing.
2.9.2 Login User IDs and Passwords
You must confirm login information for key interfaces, and document the information using Table 2.
NOTES:

e Itis assumed that the login information may be common across sites. If not, record the information
for each site.

e Consider the sensitivity of the information recorded in this table. While all of the information in the
table is required to complete the upgrade, there may be security policies in place that prevent the
actual recording of this information in a permanent form.

11 E85338-01



Software Upgrade Procedure

Table 2 Login IDs, Passwords and release Information

Item

Value

CMP servers

NOTE: Some older releases do not use
admusr, instead use the default root SSH
login.

GUI Administrator Login User/Password

admusr password:

MPE/MRA/Mediation

admusr password:

Target iLO iLO Administrator Login User/Password
Target OA OA Administrator Login User/Password
PM&C server GUI Administrator Login User/Password

admusr password

Software Upgrade Target Release?

Target Release Number

Policy 12.3 software ISO image filenames

1 The IS0 image filenames should match those referenced in the Release Notes for the target release.

12
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3. THEORY OF OPERATION

3.1Upgrade Manager Page

The Upgrade Manager represents a significant shift from previous upgrade pages. In the past it was up to
the operator, with assistance from a MOP, to know the correct sequence of server selects and menu
selections. The new Upgrade Manager takes a different approach. It determines the next course of action
to either

1. Begin/continue upgrading a cluster
2. Begin/continue backing out a cluster.

IMPORTANT: There is a point implicit in the list above: upgrade is now presented from a cluster
perspective, instead of a server perspective.

The shift in perspective has a number of ramifications, most noticeably it is no longer possible to select
individual servers or to bulk select a group of servers. In fact, in order to perform any operation, it is
necessary to select a cluster first.

Another change is that certain operations are performed automatically on behalf of the operator. These
operations are not presented to the operator as an option. However, the operator can see what has been
done using the upgrade log.

Current IS0 standard-upgrade-12.1.200 22.1.0

DFiter  Columns

=l [] CMP Site1 Cluster (2 Servers)
chrisd ¥ Sandiy 1m12.310 121.200_221.0 +/ Intiate upgrade Completed Successfuly al Feb 8, 2015 213015,
chris1d L Active 1112310 1212002210

=1 [ TestMPE (2 Servers)

cheis16 ¥ Active: 1112310 1212002210 ) Initiate upgrade Completed Successhuly al Feb 9, 2015 10:25:15,

chiisis W Standby 1112 310 121.200_2210 ) Initiate upgrade Completed Successfuly at Feb 9, 2015 122346

Figure 1 Sample display of the Upgrade Manager page

For the most part, the items in the display are self-explanatory. The following items are often used during
the upgrade.

e Start Rollback and Start Upgrade buttons (upper left): If a cluster is selected and these buttons are
disabled (grey), it means that there is not an appropriate action to take at this time. However, if a
button is not disabled (white), then it means that there is a preferred action that can be taken to
upgrade (or backout) the cluster. Normally, upgrading a cluster is a well-defined fixed procedure.
However, in some cases there are a number of valid sequences. Selecting the preferred step causes
the Upgrade Director to choose the default sequence. Only use the Upgrade Manager to perform
upgrades unless the instructions direct otherwise.

e Alarm Severity: This column is used to indicate if there are alarms associated with a server. If so, it
displays the severity of the most severe alarm here. It is important to explain the intent of this
column. The intent is to give a visual indication that the particular server is experiencing alarms.
This is not a reason to panic: During the upgrade, it is expected that the servers raise alarms:

o The CMP raises alarms to indicate that it is initiating upgrade activity.
o Servers report alarms to indicate that their mate servers are offline.

However, if alarms are asserted for a server, it is good practice to look at the alarms prior to
initiating upgrade activity on them.

13 E85338-01



Software Upgrade Procedure
e Up to Date: This column is used to indicate the state of the code on the server.

o N—Server is running old code needs to be upgraded
o Y—Server is running new code.

o N/A—Upgrade is not appropriate and/or the server is in a bad state

3.1.1 The Upgrade Log

Within the Upgrade Manager page, the operator can access the upgrade log. This displays attributes of the
various actions (manual and automatic) that have been performed on the selected cluster. It is important
to note that this is NOT the audit log. The audit log is meant to track what the operator has done. This log is
meant to capture the sequence of upgrade activity—whether it was initiated by an operator or
automatically triggered.

E upgradeDirectorTicketsDialog jsp - Google Chrome ==l X
[7 10.148.242.110/mi/pages/upgradeDirectorTicketsDialog.jsp?id=C2013&name=TestMPE
Upgrade Log
;_Il-sl[||[| i:l\ _c1F 1154:1::-:? 4 Fiter | | Calurnns ¥
[[n] Pare... Action Name Start Time End Time Durat... | Scope Hostname Result Mode Description

il 0 Preflight Check 2192015 9:21:36 2/%20159:21:54 . 0:00:17 - Server . chris16 Success IManual User inttiated action: ..
7 6 Initiate upgrade 21972015 9:21:54 2/92015 10:25:06 : 1:03:11 : Server : chris16 Success Automatic  Automatic action initi....
8 & Modify the role/replication ... | 2/9/2015 9:21:54 2/%2015 2:21:58 | 0:00:04 : Cluster @ TestMPE Success Automatic | Automatic action for ..
9 B Wait for replication to sync... | 2/9/2015 10:25:06 2/9/2015 10:25:15 - 0:00:09 : Server : chris16 Success Automatic © Automatic action wait....
10 0 Failover to new version 2/9/2015 11:20:08 2/%/2015 11:20:08 = 0:00:00 & Cluster = TestMPE Success Manual User inttiated action: ...
11 0 Preflight Check 2192015 11:20:41 22015 11:20:54  0:00:12 | Server  chris15 Success Manual User intiated action: ...
12 11 Initiate upgrade 21972015 11:20:54 2/%201512:23:06 : 1:02:11  Server . chris15 Success Automatic = Automatic action initi....
13 11 Modify the role/replication ... & 2/9/2015 11:20:54 2/%2015 11:20:59 : 0:00:04 : Cluster @ TestMPE Success Automatic | Automatic action for ...
14 11 Wait for replication te sync... | 292015 12:23:06 /%2015 12:23:46 | 0:00:40 : Server  chris15 Success Automatic © Autematic action wait. ..
15 11 Madify the role/replication ... @ 2/9/2015 12:23:06 2/9/2015 12:23:10 - 0:00:04 : Cluster @ TestMPE Success Automatic © Automatic action for ...

Figure 2 Upgrade Log

3.1.2 Optional Actions

It is possible to perform every step in the upgrade process using the Upgrade and Backout buttons. When
the operator clicks one of these buttons, the Upgrade Director performs the next preferred action.
However, there are times that the operator may want to take a slightly different—but still legal—
procedure. For example, the Upgrade Director has a preferred order in which it upgrades a georedundant
cluster. However, if the operator wanted to deviate from that default procedure—say to restrict upgrade to
servers in a particular site—then they can use the optional actions menu. It is important to note that this
menu is ONLY populated with legal/reasonable actions. Actions that are wrong or inconsistent are not be
displayed.

If the operator selects an optional action, they can go back to using the default/preferred at any time.

14 E85338-01
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3.1.3 The ISO Select

In the upper right hand corner, there is an item called the Current ISO. In some respects the term I1SO is
misleading. A better description might be upgrade procedure. This item shows the upgrade procedure that
is being used. In common cases, this is going to be either:

e Astandard (full) upgrade to version XXX

e Anincremental upgrade to version XXX

Upgrade Manager

Crrerti5D: Install it

SttRelback S Jogrsse B Upyiace 23 DFer Cobrs v Avanced

To start a new upgrade, click on this item. The Upgrade Director searches for valid upgrade procedures. In
order to minimize confusion, these upgrade procedures are usually embedded within a CMP ISO file. This
way, the CMP ISO file is always tied to the corresponding upgrade procedure.

When you select a new ISO file, you are telling the Upgrade Director to abandon the current upgrade
procedure in favor of a new procedure.
3.1.4 Introducing Upgrade Director Behavior

The Upgrade Director is a component that tracks the state of the servers, cluster and system during an
upgrade. From a user perspective, the Upgrade Director is hidden. However, there are
conventions/operating principles that have visible effects.

3.1.4.1  Alarm Philosophy

During an upgrade, the Upgrade Manager asserts (that is, generates) and displays alarms. An upgrade
typically triggers multiple minor, major, and critical alarms as servers are taken out of service, go into
forced standby, or fail over. This is normal and to be expected. Figure 3 shows an example of an upgrade in
progress asserting multiple transient alarms.

NOTE: Click on the active alarms summary, in the upper right corner of every CMP page, to display a list of
current active alarms.

15 E85338-01
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»

m

Jra = D = [ o ® < = :
Major Minor
18
Upgrade Manager
Current 150: 12.1.2.0.0 221.0

Start Rollback Continue Upgrade View Upgrade Log D Fiter Columns »+  Advanced
= Name Alarm 5. ‘ Up to ... | Server Role Prev Release Running Release Upgrade Operation
= [J cmp sitet Cluster (2 Servegys)

CMP1-SITEA & Minor Standby 10.5.6_1.1.0 12.1.2.0.0_221.0 +*) Initiate upgrade Completed Successfully at Jul 12, 2016 13:14:59.

CMP2-SITEA 2) Major Active 1056_1.1.0 121.200_221.0 nia
= [ cMP site? Cluster (2 Serveys)

CMP2-SITEB & Minor Active 10.56_1.1.0 12.1.2.0.0_221.0 +) Inttiate upgrade Completed Successfully at Jul 12, 2018 14:16:10.

CMP1-SITEB & Minor Standby 10.5.6_1.1.0 12.1.2.0.0_22.1.0 +) Inttiate upgrade Completed Successfully at Jul 15, 2016 5:42:13.
= [ MOF Cluster (3 Servers)

MDF3-SITEB N Spare 10.5.6_1.1.0 10.5.6_1.1.0 nia

MDF2-SITEA N Standby 1056_1.1.0 1056_1.1.0 nia

MDF1-SMEA N Active 10.5.6_1.1.0 10.5.6_1.1.0 nia
] [¥] MPE Cluster (3 Servers)

WMPE3-STER ¥ Major [N 003 10.56_1.1.0 10.5.6_1.1.0 Initiate upgrade :: Initiate upgrade (Elapsed Time: 0:00:33)

MPEZ2-STEA X) Critical Active 10.5.6_1.1.0 12.1.2.0.0_221.0 +) Initiate upgrade Completed Successfully at Jul 15, 2016 14:16:41.

MPE1-SITEA %) Critical N Standby 10.5.6_1.1.0 10.5.6_1.1.0 nia
= [ MRA Cluster (3 Servers)

MRA3-SITEB N Spare 10.56_1.1.0 1056_1.1.0 nia

WMRA2-SITEA N Standby 10.5.6_1.1.0 10.56_1.1.0 nia

Figure 3 Upgrade in Progress Showing Transient Alarms

The Upgrade Manager clears alarms when appropriate, such as when server and cluster upgrades are
complete. Table 3 lists transient alarms that the Upgrade Manager can assert during an upgrade.

Table 3 Transient Alarms Asserted During a Typical Upgrade

NI:I:I:'; . Severity Name

31227 Critical HA availability status failed

31283 Critical HA Server Offline / Lost Communication with server?
70001 Critical QP_procmgr failed

70025 Critical QP Slave database is a different version than the master
31233 Major HA Path Down

70004 Major QP Processes down for maintenance

31101 Minor DB replication to slave failure

31106 Minor DB merge to parent failure

31107 Minor DB merge from child failure

31114 Minor DB replication over SOAP has failed

2The name of alarm 31283 changed in 12.2.2: Before 12.2.2, it was “HA Server Offline,” with 12.2.2 it became “Lost
Communication with Server.” Depending on the original release and the upgrade progress, you might see the alarm

with one or the other name.
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Alarm Severit Name
Number 4

31282 Minor HA Management Fault

70500 Minor System Mixed Version

70501 Minor Cluster Mixed Version

70502 Minor Cluster Replication Inhibited

70503 Minor Server Forced Standby

70507 Minor Upgrade in Progress

The Upgrade Manager also asserts an alarm if an unexpected error prevents it from continuing the
upgrade. You should review all active alarms after each upgrade step to ensure that the alarms are
expected. Alarms are described in the Troubleshooting Guide, Release 12.3, available at the Oracle Help
Center.

3.1.4.2 General Upgrade Procedure

In general, the upgrade of a server goes through the following steps:

1. Preflight checks—look for certain conditions which guarantee a failed upgrade. If such conditions
are detected, fail. There are two principles behind the preflight checks

a. ltis better to fail early in a recoverable way than to fail late in an unrecoverable way.

b. Preflight checks are VERY narrow. This prevents false positives for an otherwise valid upgrade.
2. The upgrade itself
3. Wait for replication to synchronize.

This procedure is in place so that it should not be necessary to login to the target server to verify
conditions. You should be able to stay on the Upgrade Manager page.

3.1.4.3 Upgrade Order

With a two server cluster, there is only a single valid order:
1. Upgrade the standby
2. Failover
3. Upgrade the remaining server.

With georedundant clusters, there are many valid permutations. The default order that the Upgrade
Director takes is:

1. Upgrade the standby server
2. Failover
3. Reapply the configuration
NOTE: This requires you to navigate away from the Upgrade Manager page
4. Upgrade the spare server

5. Upgrade the remaining server in the primary site
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3.1.4.4 Unreachable Servers

During the course of an upgrade, servers can go unreachable. This is expected and the Upgrade Manager
tries to be graceful about unreachable servers. However, if the CMP experiences a failover when another
server is unreachable, this runs into limits. The promoted Upgrade Director does not have the full
history/context. It waits until it can contact the unreachable server before it takes action on the server.
3.1.4.5 Reversing Directions

In general, it should be possible to reverse directions at any time. You should be able to upgrade a server in
a cluster, back it out, upgrade it, upgrade its mate, back that out, etc. In this sense, upgrade/backout should
be fully reversible. However, you are not permitted to reverse direction if there is an ongoing action: You
cannot kick off a backout of a server if another server in the cluster is being upgraded. You have to wait for
the upgrade to finish.

3.1.4.6  Mixed version and Forced Standby

As a general rule, if a cluster is in mixed version, then every server that is NOT running the same version as
the active server needs to be in forced standby. This way, a simple failover does not cause a change in the
version of code that is providing service.

NOTE: Forced standby is managed by the Upgrade Director and requires no user action.

3.1.4.7 Failure Handling and Recovery
Failures fall into two categories:
e Failures that the Upgrade Director is able to recover from.
e Failures that the Upgrade Director cannot automatically recover from.

Any failure should generate an UPGRADE_OPERATION_FAILED alarm. In such cases, the operation can be
attempted again. Ideally, the operator/support would investigate the original failure before repeating.
However, if the server is in an indeterminate state, the server is declared a ZOMBIE and no further action
can be taken on the server. It requires direct action by support/engineering to repair.

For the current release, recovery or even deep failure diagnosis is not exposed via the GUI.
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4. UPGRADE PREPARATION

This section provides detailed procedures to prepare a system for upgrade execution. These procedures are
performed outside a maintenance window.

NOTE: If Veritas NetBackup is being used on the system, see the Maintenance Operation Procedure for pre
and post upgrade steps.

Overview of steps:
1. Upgrade TVOE PM&C Server at Sitel (if applicable)
2. Upgrade TVOE PM&C Server at Site2 (if applicable)
3. Firmware (if applicable)
4. Upgrade Primary (Site1l) CMP
5. Upgrade Secondary (Site2) CMP (if applicable)
6. Segment 1 Sitel:
a. Upgrade MPE clusters
b. Upgrade MRA clusters
7. Segment 1Site2:
a. Upgrade MPE clusters
b. Upgrade MRA clusters
8. Segment 2 Sitel:
a. Upgrade MPE clusters
b. Upgrade MRA clusters
9. Segment 2 Site2:
a. Upgrade MPE clusters
b. Upgrade MRA clusters
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4.1 Pre-requisites

The following Procedure table verifies that all required prerequisite steps needed to be performed before
the upgrade procedure begins.

IMPORTANT: TVOE, PM&C and Firmware might need to be upgraded prior to upgrade to Policy
Management release 12.3.

Step Procedure Result
1. [ ]| Verifyall As listed in section 2.9, “Required Materials and Remote Access”
required
materials are
present

2. [] | Review Release Review Policy 12.3 Release Notes for the following information:

Notes - . . .
e Individual software components and versions included in target release.

e New features included in target release.
e Issues (bugs) resolved in target release.
e Known issues with target release.

Any further instructions that may be required to complete the software upgrade for the
target release. In particular, the supported browsers:

In release 12.2, only Mozilla Firefox and Google Chrome are fully supported.

---End of Procedure---

4.2 TVOE and PM&C Server Upgrade

Policy Management release 12.3 requires PM&C Version 6.0.3 and higher to support IPM of TPD 7.0.3 on
c-Class servers.

PM&C can IPM TPD on a c-Class server if the server is introduced either for disaster recovery (DR) or when
adding new servers to an enclosure (for example, capacity expansion).

See Appendix A to upgrade the TVOE and PM&C.

4.3Firmware Upgrade

See the release notes for the list of ISO image files required for the firmware upgrade you are installing.
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4.4 Plan and Track Upgrades
The upgrade procedures in this document are divided into the following sequential steps:
Prerequisites:
1. TVOE and PM&C Server upgraded. Firmware upgrade deployed if necessary.
2. Upgrade CMP clusters
3. Upgrade MPE/MRA clusters

Table 4 can be completed first before performing the upgrade, to identify the clusters to be upgraded and
plan the work. It can also be used to track the completion of the upgrades, and assign work to different
engineers.

NOTES:

e Policy changes or configuration changes should NOT be made while the system is in mixed-version
operation.

e Time estimates are for upgrade procedure without backout procedure. Backout procedure time is
typically the same as, or less than the upgrade procedure.
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Table 4 Upgrade information

Step Procedure Result Engineer | Time

1. []| Use the following Maintenance Windows are planned
checklist to plan the
cluster upgrades for
the entire system.

2. []| Upgrade Sitel and 3 hrs
Site2 TVOE/PM&C Site Names and

3. []| Upgrade Sitel and 3 hrs
Site2 CMP clusters. Site Names and

Each cluster takes
approximately 90
minutes to complete

4. []| Upsgrade Sitel 2 hrs
MPE/MRA clusters for | Site Names
Segment-1 Cluster List:

5. []| Upgrade Site2 clusters 2 hrs
for Segment-1 Site Names
Cluster List:

6. [ ]| Upgrade Sitel clusters 2 hrs
for Segment-2 Site Names
Cluster List:

7. []| Upgrade Site2 clusters 2 hrs
for Segment-2 Site Names
Cluster List:

---End of Procedure---

22 E85338-01




Software Upgrade Procedure
4.5Convert to Using Interval Statistics

Prior to Release 12.2, Oracle Communications Policy Management offers two methods for gathering
statistics: Manual and Interval statistics. They operate as follows:

e Manual. When configured to use this method, CMP records the cumulative values from the time
the blade became active or the operator manually reset the statistics. Statistics which represent
maximum values contain the peak value since the blade became active or was reset. This is the
system default.

e Interval. When configured to use this method, all counters reset automatically at the beginning of
every interval and write the cumulative values at the end of the interval. Statistics which represent
maximum values contain the peak value which occurred during the interval. The user-definable
interval length can be 5, 10, 15, 20, 30 or 60 minutes. The default interval is 15 minutes.

In Oracle Communications Policy Management Release 12.2, Manual statistics is no longer available. You
must migrate to Interval statistics before upgrading to Release 12.2. After the upgrade to R12.2, Oracle
Communications Policy Management uses Interval statistics only and any Manual statistics not saved are
lost.

Statistics affected by this change are reset to zero when migrating to Interval statistics. This affects both the
information presented via the CMP GUI as well as information returned using the OSSI interface. The
values for statistics which are not counters, such as active session counts, are the same in both cases. The
behavior of KPlIntervalStats is the same in both cases.

It is recommended that the following actions are taken well in advance of the upgrade procedure:

1. Review your current configuration to determine which statistics method is currently being used by
navigating to GLOBAL CONFIGURATION - Global Configuration Settings = Stats Settings.

2. If Manual is being used, change the Stats Reset Configuration parameter to Interval.

3. Review any systems which access this information via OSSI to determine whether they must be
modified.

For completeness and assuredness, it is recommended to collect at least 24 hours of interval statistics
before upgrading to 12.3.

For addition information, see the following publications:
e Configuration Management Platform User's Guide

e (OSSI XML Interface Definitions Reference
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4.6 Perform System Health Check

This procedure is to determine the health and status of the servers to be upgraded and must be performed
at least once within the time frame of 24 to 36 hours prior to the start of a maintenance window.

Step Procedure Result

1. []| CMP GUI Access Open a supported browser (Mozilla Firefox or Google Chrome) to access the
Primary CMP GUI on its VIP address and login to verify access.

2. []| View Active Alarms Identify the cause of any existing active alarms, and determine if these may have
impact on the upgrade. Export current alarms to save into a file.

IMPORTANT: Before starting any upgrade activity, ensure that all active
alarms are understood and resolved.

3. |:| View KPI reports Verify that the system is running within expected parameters. Export current
KPIs into a file.

4. [ ]| Confirm NTP servers 1. Validate the IP connectivity between the server and NTP servers by PING.
are reachable from all
the servers (CMP,
MPEs and MRAs) to

2. Confirm that time is synchronized on each server using the following CLI
shell command:

be upgraded ntpq -np
NOTE: If the time 3. Confirm that date is correct on each server.
across the serversis | 4 check that BIOS clock is synced with the clock using the following CLI shell
out of synch, fix it first command:
and re-validate this
hwclock

step, before starting
the upgrade
procedures.

---End of Procedure---

4.7 Deploy Policy Upgrade Software

Software should be deployed to each Policy server /var/TKLC/upgrade directory, before the actual
upgrade activities. This is typically done with utilities such as SCP, WGET or SFTP. Because of the large size
of the software ISO file, sufficient time should be planned to accomplish this step. For Policy Management
release 12.3, each ISO image size is about 1.0 Gigabytes.

4.7.1 Deploying Policy Upgrade Software to Servers

There are six possible software images in this upgrade (CMP, MPE, MPE-LI, MRA, Mediation). A single image
must be deployed to the /var/TKLC/upgrade directory of each server to be upgraded, where the image is
the correct type for that server. That is, the CMP software image must be deployed to the CMP servers, the
MPE image deployed to the MPE servers, and so on.

IMPORTANT: If the deployed image type (CMP, MPE, MRA, Mediation) does not match the existing
installed software type, the upgrade fails. Example: An attempt to upgrade a CMP with a MPE software
image fails during the Upgrade action.

NOTE: To change a server from one application type to another, the server must first be cleaned of all
application software by an Install OS action using the PM&C GUI, and then the new application type
installed.

Also, if multiple images are copied into the /var/TKLC/upgrade directory, the upgrade fails.
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4.7.2 Copy ISO image files to Management Server (PM&C)

NOTE: Not all Policy Management systems use a PM&C server. If that is the case, skip to the next section.

This procedure transfers the upgrade ISO files to the PM&C servers at each site to be upgraded, and loads
the ISO files into the PM&C software image repository. This is done as a placeholder for future use of the
software.

IMPORTANT: PM&C is not used for the upgrade activities. The purpose of this procedure is to be prepared
for server recovery activities in case a server needs to be re-installed with software.

NOTES:

e |SO file transfers to the target systems may require a significant amount of time depending on the
number of systems and the speed of the network. The ISO file transfers to the target systems
should be performed prior to and outside of the scheduled maintenance window. Schedule the
required maintenance windows accordingly before proceeding.

e Because the ISO files are large, the procedure includes instructions to check the space available in
the /var/TKLC/upgrade directory before copying the ISO files to the directory. After the Add Image
action on the PM&GC, the ISO files are registered in PM&C, and stored in the
/var/TKLC/smac/image/repository directory, which is very large.

Step Procedure Result

1. [ ]| PM&CGULI: Verify that 1. Logon tothe PM&C Server GUI
there are no release 12.3 .
ISO files on the server 2. Navigate to Software = Manage Software Images.
3. Confirm that the release 12.3 1SO files do not exist. If there are files,

remove them.

2. []| SSH to PM&C server as 1. Logon asadmusr to the PM&C server.

d
admust 2. Change Target directory to /var/TKLC/upgrade and ensure there is at
least of 3.0 GB free disk space available.
$cd /var/TKLC/upgrade
$df -h /var/TKLC
NOTE: If there are ISO files in the /var/TKLC/upgrade directory, you can
remove the files to free up disk space or add the files to the PM&C
repository.
3. []| Copy release 12.3 1SO Transfer all release 12.2 I1SO files (CMP and non-CMP) into directory
files to the target /var/TKLC/upgrade using one of the following methods:
directory in the PM&C . . L .
server e SCP/WGET command in the following steps outline in this Procedure

e USBdrive

NOTE: If the directory becomes full, you may have to use the scp command
to transfer one ISO file at a time. Verify that the ISO file is in the directory
before adding the next ISO file. You may also use the
/var/TKLC/smac/image/isoimages/home/smacftpusr directory which has
more available space.
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Step Procedure Result
4. []| PM&CGUI: Adding the Software - Manage Software Images
new release 12.3 ISO files . .
1. Click Add Image to select the ISO files that were transferred to the
PM&C server.
B S Main Menu
B & Hardw: Manage Software Images & Help
ey Wed Hov 16 20:11:36 2016 UTC
Configuration
Image Name Type Architecture Description
cmp-12.1.1.0.0_14.1.0-x86_64 Upgrade  x86_64 12.1.1 CMP
cmp-12.2.0.0.0_49.1.0-x86_64 Upgrade  x86_64 12.2 CMP (810)
cmp-12.2.0.0.0_61.1.0-x86_64 Upgrade x86_64 12.2CMP (1177)
mpe-12.1.1.0.0_14.1.0-x86_64 Upgrade  x86_64 12.1.1 MPE
mpe-12.2.0.0.0_49.1.0-x86_64 Upgrade  x86_64 12.2 MPE (8/10)
mra-12.1.1.0.0_14.1.0-x86_64 Upgrade x86_64 121.1 MRA
mra-12.2.0.0.0_49.1.0-x86_64 Upgrade  x86_64 12.2 MRA (8/10)
<& Help TPD.nstall-7.0.2.0.0_86.28.0-OracleLinux6.6-x86_64 Bootable x86_64 12.1.1TPD
7 Logout TPD.install-7.0.3.0.0_86.43.0-OracleLinux6.7-x86_64 Bootable x86_64 122 TPD
Pause Updates
‘ Add Image | Edit Image
Pl
Path: NarﬁKLCiupgradefcmp-TﬁU.D 0_G61.1.0-x86_G4d.iso -
12.2 CME (11/7)
Description:
|Add New 1rnage|
2. Click OK on the confirmation dialog.
5. []| PM&CGUI: Verify that Navigate to Software = Manage Software Images.
the 1SO files were added . . . .
The status of the image being added can be monitored using the Task
successfully . . . .
Monitoring menu with the screen display as the following:
Background Task Monitoring
D Task Target Status State Running Time  Start Time Progress
) 610 Addimage Done: cmp-12.1.2,0.0_22.1.0-x86_64 COMPLETE 0:00:20 igfg%ﬁ“ 100%
NOTE: The added ISO files are now stored in the
/var/TKLC/smac/image/repository directory
---End of Procedure---

4.7.3 Distribute Application ISO Image Files to Servers

This procedure applies to all server types. It assumes that the ISO image files are electronically copied to

the sites to be upgraded.

NOTE: ISO transfers to the target systems may require a significant amount of time depending on the
number of systems and the speed of the network. The ISO transfers to the target systems should be
performed prior to and outside of the scheduled maintenance window. Schedule the required maintenance
windows accordingly before proceeding.

The distribution can be done in one of the following ways:

e Manual Distribution

e PM&C Distribution
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4.7.3.1  Manual Distribution

Step Procedure Result
1. []| Transfer ISO files to Transfer release 12.3 ISO files (CMP and non-CMP) into the
Policy server. /var/TKLC/upgrade directory on the respective server using one of the

following methods:
e SCP/WGET command
e USBdrive

If the images are on a server in the same network, scp the files using the CLI,
for example, for CMP:

e Copy CMP software ISO file to ONE of the other CMP servers:

$sudo scp cmp-12.2.0.0 22.1.0-x86 64.iso
user@remote host.com:/var/TKLC/upgrade/

Repeat for one server of all clusters.

NOTE: After copying the ISO to one of the respective servers, the ISO
Maintenance function is used to upload to the rest of the servers.

---End of Procedure---

4.7.3.2 PMA&C Distribution

The PM&C product is not used during Policy Management upgrade and backout procedures. However, if
your topology is supported by PM&C servers, you should add the Policy Management ISO images to the
PM&C image repository to support new installations and server field replacements.

Collect the following information and material beforehand:
e The URL of the PM&C server and the guiadmin password

e The Policy Management ISO files, loaded into the directory /var/TKLC/upgrade on the PM&C
server

NOTE: You can instead add images from the following sources:
e Media mounted in the CD/DVD drive of the PM&C host
e USB media attached to the PM&C host
e External mounts (prefix the directory with extfile://)
e These local search paths:
o /var/TKLC/upgrade/
o /var/TKLC/smac/image/isoimages/home/smacftpusr/

NOTE: CD, DVD, and USB images mounted on the PM&C VM host must first be made accessible to the
PM&C VM guest. To do this, go to the Media tab of the PM&C View VM Guest page on the PM&C VM
Management page.

The following procedure assumes the ISO file is located in the directory /var/TKLC/upgrade on the PM&C
server.
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Step Procedure

Result

1. [ ]| LogintoPM&C

Open a browser, enter the URL of the PM&C server, and log in as guiadmin.

The PM&C Main Menu opens. For example:

ORACLE piatform Management & Configuration  6.2.0.0.0-62.16.0 7] Pause Updates | Help | Loggedin Account guiadmin [+ | Log Out
= g vantien .

!;Ha;ﬂ“ﬂ Platform Management & Configuration
@ 03 Soware

0 Wangement
@ Castorage
& 0 Administaton
% 01 Status andanage

) TaskHonitoring

SHen

] Lega Notices

Logaut
® HPMAC-02
Login Name: uiadrin
Last LoginTime: 2015~ 160857
Last Login P Address: = 226.20¢
RecentFailed Login Atemps:
e and o s aites. Oter resp
Copright © 2010, 2018, Orade and/or s afflstes. All ighs eserved
[ 1 | Updates enabled
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Step

Procedure

Result

2.

[

Select the ISO image

1. Select Main Menu = Software = Manage Software Images

The Manage Software Images page opens. For example:

= Main M [ -

£ 8 Hain enu Main Menu: Software -> Manage Software Images
[ 0 Haraware
B 3 Software

[ Software Inventary
[2) Manage Software Images

[ VM Management
& £ Storage cmp-12.1.1.0.0_14.1.0-x85_64 Upgrade xB6_64 CHP 124.1.0.0

Image Name Type. Architecture  Description

&) (2] Administration TPD install-7.0.3.0.0_86 43.0-OracleLinux6 7-x86_64 Bootable 8664
[+) (1 Status and Wanage
[2] Task Monitoring
@ Help
[0) Legal Notices
(@ Logout
« 0] ’

Add Image

opyright & 2010, 2016, Oracle and/or its affiliates. All rights reservad

2. Click Add Image (at the bottom of the page).The Manage Software
Images [Add Image] page opens. For example:

Main Menu: Software ->» Manage Software Images [Add Image]

Images may be added fram any ofthese sources:

« Oracle-provided media in the PM&C hosts CD/DVD drive (Refer to Note)
+ UUSB media aftached to the PM&C’s host (Refer to Note)
« BExternal mounts. Prefix the directory with "extfile /™.
» These local search paths:
o NarMKLClupgrade/* iso
o NarTKLC/smacimagefisoimages/homeism Fliso

Mote: CD and USB images mounted on PM&C's VM host must first be made accessible to the PM&C VM guest To do this, go to the Media tab
ofthe PM&C guest's View VM Guest page in VM Management.

Path: MarTKLC/upgrade/mpe-12.1.2.0.0_22.1.0-x86_64.is0 d

Description:

Add New Image Cancel

3. Select the ISO file from the Path dropdown list and click Add New
Image.

Tip: You can enter a description of the ISO file before adding it.
You are prompted:

- Click OK to remove the image from /var/TKLC/upgrade directory
after it is added to the repository.

- Click Cancel to leave it there.
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Step Procedure Result
3. []| Move the ISO file to the Click OK to move the file (or Cancel to copy it).
repository

The ISO file is loaded into the PM&C image repository in the background.
Tip: You can click the Tasks dropdown list to check the progress of the task.

When the upload is complete, the ISO file displays in the list. For example:

Main Menu: Software -> Manage Software Images

Image Name Type Architecture Description
cmp-12.1.1.0.0_14.1.0-x86_64 Upgrade *B6_64 CMP 121100 i
TPD.install-7.0.3.0.0_86.43.0-OracleLinuxb 7-x86_64 Bootable *¥B6_64

mpe-12.1.2.0.0_22.1.0-x86_64 Upgrade x86_64

m

Add Image

Copyright @ 2010, 2016, Oracle and/or its affiliates. All rights reserved.

4. |:| Verify that the image is Enter the following command:

no longer in the directory $ sudo 1ls /var/TKLC/upgrade
$
5. |:| Load addition files If you are loading multiple I1SO files into the image repository, repeat steps 2

through 4 until all files are loaded.

6. |:| Remove media When you finish, remove the CD/DVD media or unmount the USB device.

---End of Procedure---
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4.7.4 Backups and Backup Locations

Perform the backups prior to the maintenance window period.

Step Procedure Result
1. []| SSH CLI/iLO: Access the IMPORTANT: Server backups (for each CMP and non-CMP server,
server to be backed up active/standby/spare), and the system backup (from the active
NOTE: System backup is | CMP), must be collected and readily accessible for recovery
done on active CMP operations.

servers ONLY. 1. Login into the active Primary CMP server.

2. Navigate to the following through platcfg utility.
Ssudo su - platcfg
3. Policy Configuration->Backup and Restore—>Server Backup

Provide (or use the suggested) ISO backup filename in the default backup
location path of:

/var/camiant/backup/local archive/serverbackup/<filename>.iso

4. Go back to the previous menu (Policy Configuration = Backup and
Restore) and select System Backup

Provide (or use the suggested) tarball backup filename in the default
backup location path of:

/var/camiant/backup/local archive/systembackup/<filename>.tar.gz

Set backup location |

The iso path:

Use arrow keys to move between options | <Enter> selects
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Step Procedure Result
2. |:| SSH CLI/iLO: Verify the If default location is accepted in the previous step, change to the following
backup ISO file directory and verify the file. For example for an MPE server backup:

$ cd /var/camiant/backup/local archive/serverbackup

$ ls <hostname>-mpe- 12.2.x..Xx-serverbackup-
<yyyy><mm><dd><hhmm>.iso

And for the system backup:
$ cd /var/camiant/backup/local archive/systembackup

$ ls <hostname>-cmp 12.2.x..x-systembackup-
<yyyy><mm><dd><hhmm>.tar.gz

3. []| Copy backup files. 1. Copy the files to remote server or local workstation/laptop.

Example of a remote server copy.

$ sudo scp
/var/camiant/backup/local archive/systembackup/xx tar.gz
<remoteserver ipaddress>:<destinationpath>

2. Remove the backup ISO file from the TPD Sever.

$sudo rm <backup filename>.iso

4. |:| Identify backup location Backup location is:

Instructions to access to backups are as follows:

---End of Procedure---
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4.7.5 Changing Non-Default root and admusr Passwords
4.7.5.1  Improve Password Security

The default password hash prior to Policy 12.0 is MD5. MD5 is now considered a weak hash that can be
brute force cracked in a reasonable amount of time. The best hash to use is SHA512. This is currently the
strongest hash supported on the platform. Due to this change, during upgrade, all non-default passwords
are automatically expired. This causes issues during upgrade from pre-12.2.1to 12.3 and above. To prevent
those issues, the following procedure has been created.

4.7.5.2 Impact

After this procedure is run, the root and admusr password are hashed with the strongest possible method,
SHA512.

This procedure only addresses root and admusr passwords. Other users should also update their password
to benefit from the new hashing. If they are not changed prior to the upgrade to 12.3, they are expired post
upgrade.

IMPORTANT: The following procedure must be performed prior to the upgrade to 12.3 only if the root or
admusr passwords are non-default.

Order to perform the upgrade on an In-Service Policy Management system:
1. Standby CMP servers
2. Active CMP servers
3. Standby MPE/MRA/Mediation servers
4. Spare MPE/MRA/ Mediation servers
5. Active MPE/MRA/ Mediation servers

Step Procedure Result
1. []| Login to the active CMP For an upgrade from 12.2.x, login as admusr and change to root using the
server following command:
Ssudo su
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2. []| Checkthe password field | Issue the following
of root and admusr #egrep '” (root|admusr)' /etc/shadow
EXAMPLE OUTPUT
root:$6SmErKrEsA$83n5G8dR3CgBJIJMEABL 6b4847TEXusUnzTaWNJgE1347B
.WhLbIc.Cga.nmYCdQYSNwkst1CtUBi.tBSwWujUd.:16825:0:99999:7:::
admusr:$6SmUstAfa$Sgn2B8TsW1Zd7mgD333999Xd6NZnAEgyioQJ7gidxuft
SQpls6A5Jxhu8kjDT8AIgcYQR5Q1ZAtSNBOG. Tmkyq/:16825::::: ¢
NOTES:
e If the first two characters after the colon are $6, then this procedure is
not needed on this server. Skip to the next section.
e If the first two characters after the colon are not $6, then it is probably
S1 (MD5) and this procedure should be followed for this server. Continue
on with step 3
3. |:| Order to perform the Perform steps 4-15 on each server in the following order:
change
& 1. Standby CMP
2. Active CMP
3. Standby non-CMP servers
4. Spare non-CMP servers
5. Active non-CMP servers
4. |:| Login to the Server For an upgrade from 12.2.x/12.2.x, login as admusr and change to root using
the following command:
$sudo su
5. [ ]| Checkout revisions Issue the following command:

#rcstool co /etc/pam.d/system-auth
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6. [ ]| Modify the system-auth 1. Open the system-auth file.
file #vi /etc/pam.d/system-auth
2. Modify the file. Change the md5 value to sha512

Current Line:

password sufficient pam unix.so md5 shadow nullok
try first pass use authtok

Modified Line:

password sufficient pam unix.so sha5l2 shadow nullok
try first pass use authtok

a0 try ra

o sha512 shadow nullok try first pass use authtok

7. []| Save thefile

If the file required changing:
#rcstool ci /etc/pam.d/system-auth
If the file was already configured:

#rcstool unco /etc/pam.d/system-auth

8. [ ]| Checkout revisions for
login.defs file

#rcstool co /etc/login.defs

9. []| Editlogin.defs file

Shadow password suite configuration

3.

Open the login.defs file.

#vi /etc/login.defs

Change the encrypt method from MD5 to SHA12.
Current Line:

ENCRYPT METHOD MD5

Modified Line:

ENCRYPT METHOD SHA512

NOTE: The line to edit is near the bottom of the file.
Comment out the following line if necessary.

MD5_CRYPT ENAB yes
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10. [_] | Save the File e If the file required changing
#rcstool ci /etc/login.defs
e If the file already was configured

#rcstool unco /etc/login.defs

11. [ ]| Checkout revisions for Checkout the file.

the SIS file # rcstool co /etc/libuser.conf

12. |:| Edit the libuser.conf Open the 1ibuser.conf file and change the crypt style from md5 to shal2

file #vi /etc/libuser.conf
e Current Line:
crypt style = md5
e Modified Line:
crypt style = sha5l2
NOTE: The line to edit is close to the top of the file.
After setting the password, the passwords are now successfully encrypted
and are using SHA512 (the strongest hash algorithm).
13. [ ]| Save the File e Ifthe file required changing

#rcstool ci /etc/libuser.conf

e [fthe file already was configured

#rcstool unco /etc/libuser.conf

14. [ ]| Setthe admusrandroot | e  For root user
passwords #passwd root
e Foradmusr user:

#passwd admusr

NOTE: After setting the password, the passwords are now successfully
encrypted and are using SHA512 (the strongest hash algorithm).

15. |:| Verify Logout of the current session and then login using the new password
credentials.

---End of Procedure---
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5. UPGRADE CMP CLUSTERS (12.2.X TO 12.3)
This procedure upgrades the Sitel CMP cluster first, and if needed, upgrade the Site2 CMP cluster in a
single maintenance window.
5.1Upgrade CMP Clusters Overview
1. Upgrade Primary CMP cluster
a. Start upgrade
b. Failover
c. Logbackinto the CMP GUI
d. Continue upgrade
2. Upgrade Secondary CMP cluster
a. Start upgrade
b. Failover
c. Continue upgrade

This procedure should not be service affecting, but it is recommended to perform this in a Maintenance
window.

It is assumed that the CMPs may be deployed as 2 georedundant clusters, identified as Sitel and Site2 as
displayed on the CMP GUI. When deployed as such, one site is designated as the Primary Site (which is the
site that is managing the Policy system), and the other is as Secondary site (this site is ready to become
Primary site, if needed).

If the System is deployed with only ONE CMP, then the upgrade of the Secondary CMP can be skipped.

Identify the CMP sites to be upgraded, and verify which site is the Primary site and which site is the
Secondary site:

Topology
Operator Site Designation
CMP Sites Site Name (Sitel or Site2) CMP Server-A CMP Server-B
Server-A Hostname Server-B Hostname
. . Server-A IP Address Server-B IP Address
Primary Site
Server-A HA Status Server-B HA Status
Server-A Hostname Server-B Hostname
. Server-A IP Address Server-B IP Address
Secondary Site
Server-A HA Status Server-B HA Status
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IMPORTANT:

e Sitel CMP MUST be upgraded to the new release first, before the Site2 CMP
e CMP servers MUST be upgraded first, before the non-CMP clusters

5.1.1 Upgrade Primary CMP Cluster

Step Procedure Result

1. []| CMP GULI: Verify System Wide Reports = Alarms—>Active Alarms

alarm status. . . . . .
e  Confirm that any existing alarm is well understood and is ono impact to the

upgrade procedure.

e Capture a screenshot and save it into a file for reference.

2. |:| CMP GUI: Identify 1. Navigate to Platform Setting=>Topology Settings = All Clusters

and record the CMP

Cluster Settings
CIUSterS Name Appl Type Site OAM VIP Server-A Server-B Server-C Operation
Preference
CMP Sitel Cluster (P) CMP Site1l NfA 10.240.152.88/26 | 10.240.152.75 | 10.240.152.76 NfA View Demote
Cluster
CMP Site2 Cluster (S) CMP Site2 N/A 10.240.152.89/26 | 10.240.152.98 | 10.240.152.99 NS& View Delete
Cluster
guam-mpe-1 MPE Normal N/A (F) 10.240.152.79 | 10.240.152.80 |10.240.152.101 View Delete
/A (5)
guam-mra-1 MRA Normal N/A (P) 10.240.152.77 | 10.240.152.78 | 10.240.152.100 View Delete
N/A (S)

2. Note which cluster is the primary and which cluster is the secondary.

The Primary CMP is noted with a P in parenthesis and a Secondary CMP is
noted with an S in parenthesis.

3. Save a screenshot for future reference.

3. |:| CMP GUI: Verify the | 1. Navigate to Upgrade = Upgrade Manager.
status of the CMP 2. Confirm the CMP clusters have the following:
clusters

- Active/Standby status
- Running release 12.2.x

3. Navigate to Upgrade -=> ISO Maintenance.

4. Verify that release 12.3 ISO files are on at least one of each server types
(CMP/MRA/MPE/Mediation)—Meaning, a copy of the MPE ISO file is on one

of the MPE servers, an MRA ISO file is on one of the MRA servers and a copy of
the CMP ISO file is on one CMP server
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Step Procedure Result
4. [ ]| SSHCLI Primary 1. Exchange keys to all servers from the Sitel (Primary) Active CMP.
Active CMP:

2. Login as admusr user and run the following command:
Exchange Keys

$sudo gpSSHKeyProv.pl --prov

3. Enter the password for user admusr

4. Ensure that the keys are exchanged successfully with all the server clusters:

guam-cmp-la ...

guam-mra-1b ...

juam-mra-la ...
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Step Procedure

Result

5. []| €MP GUL: Push the
Release 12.2
upgrade scripts to

1. Navigate to Upgrade = I1SO Maintenance.

2. Select all the servers in the topology as shown.

all servers 3. Select Operations = Push Script.
ISO Maintenance { Last Refresh :11/09/2016 10:07:23 )
[ oo v [ _fien 7] Operations
Name Appl Type P Running Release zp\ID:d ::s
=] CMP Sitel Cluster CMP Sitel Cluster ==t
guam-cmp-la CMP Sitel Cluster 10.240.152.75 12.1.1.0.0_14.1.0 cmp-12.2.U.U.U_61.L.U-x86_64.i50
guam-cmp-1b CMP Sitel Cluster 10.240.152.76 = 12.1.1.0.0_14.1.0
= guam-mpe-1 MPE
guam-mpe-1a MPE 10.240.152.79  12.1.1.0.0_14.1.0 ¥lmpe-12.2.0.0.0_61.1.0-x86_64.is0
guam-mpe-1b MPE 10.240.152.80 12.1.1.0.0_14.1.0
=] guam-mra-1 MRA
guam-mra-1a MRA 10.240.152.77 12.1.1.0.0_14.1.0 rr|ra-12.2.0.0.0_61.1.0-x86_64-i5D
guam-mra-1b MRA 10.240.152.78 12.1.1.0.0_14.1.0
4. At the popup warning to execute Push Script click “OK” to continue the
operation.
After approximately a minute, a successful information window similar to this
displays:
Push Script
guam-cmp-1a 10.240.152.75 0K
guam-cmp-1b 10.240.152.76 0K
guam-mpe-1a 10.240.152.79 0K
guam-mpe-1ib 10.240.152.80 0K
guam-mra-1a 10.240.152.77 0K
guam-mra-1b 10.240.152.78 0K
6. [ ]| CMP GUI Access 1. Navigate to Upgrade = I1SO Maintenance.

into Primary CMP
Server—Remove old
ISO files from
servers.

2. Select the servers that show old ISO files.

3. Select the server cluster and select Operations =>Delete I1SO to remove any
older ISO files.

Columns ] [ Fiters ] |
Push Script
Name Appl Type Site P Running Release Upload 150
| CMP Sitel Cluster  CMP Sitel Cluster
guam-cmp-1a CMP Sitel Cluster ~ Unspecified  10.240.152.75  12.1.1.0.0_14.1.0 [[lomp-12.2.0.0.0_61.1.0-x86_64.is0[100%]
guam-cmp-1b CMP Sitel Cluster  Unspecified  10.240.152.76  12.1.1.0.0_14.1.0 [lemp-12.2.0.0.0_61.1.0-x86_84.iso[100%]
CMP Site2 Cluster ~ CMP Site2 Cluster
guam-cmp-2a CMP Site2 Cluster  Unspecified  10.240.152.98  12.1.1.0.0_14.1.0
gquam-cmpzh CMP Site? Cluster  Unspecified  10.240.152.99  12.1.1.0.0_14.1.0

4. Click OK to continue and wait until seeing the successful deletion message

5. Wait until the ISO Maintenance page is refreshed and the ISO column doesn’t
show any old ISOs.
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7. []| €MP GUL: Distribute | 1. Navigate to Upgrade - 1SO Maintenance.
ISO files to
2. Filter by server type (optional, but preferred ste
CMP/MPE y ype (op , butp p)
/MRA/etc., servers 3. One application at a time, select one server type (CMP, MPE, etc.) to be
. upgraded.
NOTE: This step Pe
depends on the I1SO NOTE: The ISO files for each application type must already be copied over to at
file type. Distribute least one server. See “Distribute Application ISO Image Files to Servers”.
ISO files accordingly. .
BY- 1 4 select Operations = Upload I1SO
coimns v [ riee v] [ opmetens___v]
Push Script
: .
Name Appl Type Site P Running Release
{51771} cMPsitst Cluster  CMP Sitel Cluster Delete 150
777777 [T guam-cmp-1a CMP Sitel Cluster  Unspecified  10.240.152.75 = 12.1.1.0.0_14.1.0 [_lcmp-12.2.0.0.0_61.1.0-x86_64.iso[100%]
|l guam-cmp-1b CMP Sitel Cluster  Unspecified  10.240.152.76  12.1.1.0.0_14.1.0 [lcmp-12.2.0.0.0_61.1.0-x86_64.iso[100%]
= CMP Site2 Cluster CMP Site2 Cluster
guam-cmp-2a CMP Site2 Cluster  Unspecified  10.240.152.98 12.1.1.0.0_14.1.0
guam-cmp2h CMP Site? Cluster  Unspecified  10.240.152.99  12.1.1.0.0_14.1.0

5. Fillin the dialog with the following information:
Mode: Select SCP
ISO Server Hostname/IP: <IP_address_where_ISO_files_are_located>
User: admusr
Password: <admusr_password_for_the_server>
Source ISO file full path: /var/TKLC/upgrade/ <server_type_iso_filename>
| upload1s0toguam-mpe-1a,guamempetb |

Mode: | scp :

150 Server
10.240.152.79
Hostname / IP !
User |admusr
Password |-"““.
s;tl.;‘r:e 150 file full FKLC/upgrade/mpe-12.2.0,0.0_61.1,0-%86_64.isq|

6. Click Add.

When completed, the ISO column is populated with the ISO filename and a
notification of [100%]

= ] guam-mpe-1 MPE
guam-mpe-1a MPE encl701 10.240.152.79  12.1.1.0.0_14.1.0 [[Impe-12.2.0.0.0_61.1.0-x86_64.is0[100%]
o guam-mpe-1b MPE encl701 10.240.152.80  12.1.1.0.0_14.1.0 [_Impe-12.2.0.0.0_61.1.0-x86_64.is0[100%]
] guam-mpe-1c MPE encl702 10.240.152.101 12.1.1.0.0_14.1.0 [ Impe-12.2.0.0.0_61.1.0-x86_64.iso[100%]

Repeat for all cluster types.
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8. [ ]| CMP GUL: Verify ISO | 1. Navigate to Upgrade - 1SO Maintenance.
distribution to all 2. Verify that the release 12.3 ISO file of the correct type is shown for each
the server
server.
3. When completed, the ISO column is populated with the ISO filename and a

notification of [100%]

NOTE: For those servers where the ISO file was copied from the local machine,
there is not a 100% indicator. This indicator is only available when transferring 1ISO
files using the ISO management feature.

Name Appl Type Site IP Running Release 150
"1 CMP site1 Cluster  CMP Site1 Cluster
[T guam-cmp-1a CMP Sitel Cluster  Unspecified  10.240.152.75  12.1.1.0.0_14.1.0 [ lemp-12,2.0.0.0_61.1.0-x86_64.iso[100%]
|l guam-cmp-1b CMP Site1 Cluster = Unspecified  10.240.152.76 = 12.1.1.0.0_14.1.0 [_lemp-12.2.0.0.0_61.1.0-x86_64.iso[100%]
= B CMP Site2 Cluster CMP Site2 Cluster
= guam-cmp-2a CMP Site2 Cluster  Unspecified 10.240.152.98 12.1.1.0.0_14.1.0 Dcmp-iz.Z.D.D.D_El.i.D-xEE_EA.isn[lDD%]
O guam-cmp2b CMP Site2 Cluster = Unspecified  10.240.152.99 ~ 12.1.1.0.0_14.1.0 [_lemp-12.2.0.0.0_61.1.0-x86_64.is0[100%]
= = guam-mpe-1 MFE
El guam-mpe-1a MPE encl701 10.240.152.79  12.1.1.0.0_14.1.0 [mpe-12.2.0.0.0_61.1.0-x86_64.iso[100%]
] guam-mpe-1b MPE encl701 10.240.152.80  12.1.1.0.0_14.1.0 [[Impe-12.2.0.0.0_61.1.0-x86_64.iso[100%]
] guam-mpe-ic MPE encl702  10.240.152.101 12.1.1,0.0_14.1.0 [Impe-12.2.0.0.0_61.1.0-x86_64.is0[100%]
=] = guam-mra-1 MRA
El guam-mra-1a MRA encl701 10.240.152.77  12.1.1.0.0_14.1.0 [mra-12.2.0.0.0_61.1.0-x86_64.is0[100%]
I} guam-mra-1b MRA encl701 10.240.152.78  12.1.1.0.0_14.1.0 [Imra-12.2.0.0.0_61.1.0-x86_64.is0[100%]
B guam-mra-1c MRA encl702 10.240.152.100 12.1.1.0.0_14.1.0 [lmra-12.2.0.0.0_61.1.0-x86_64.is0[100%]
9. [_]| Primary Active 1. Logon to the primary active CMP as admusr and copy the 12.3 ISO file to the
CMP: ssh to primary /var/camiant/iso directory:
achgCIﬂPand $sudo cp /var/TKLC/upgrade/cmp-12.2.x..x.iso /var/camiant/iso/
copy iso to
/var/camiant/iso 2. Verify the copy by using the following command:

$ 1ls /var/camiant/iso/
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10. [_] | CMP GUI: Locate 1. Navigate to Upgrade = Upgrade Manager.
the new 12.3

upgrade manual

2. Select the Current ISO. In this case it is labeled Install Kit.

Upgrade Manager

Current IS0: Install Kit

Start Rollback Start Upgrade Wiew Upgrade Log AL Fitter Columns +  Advanced

A dialog box with a description of the ISO file that was copied into the
/var/camiant/iso directory opens.

3. Highlight the ISO file and click Select incremental-upgrade-12.2... located in
the bottom right corner of the window.

Select I1SOs

Last Updated: 11/9/2016 11:10:49

LDFiter  Columns =
Plzase select one of the following options:
Label Release File Path Description
incrementalupgrade... | 12.2.0.0.0_61.1.0 : /ivar/camiant/iso/cmp-12.2.0.0.0_81.1.0-x86_64.iz0 This kit is used to perform ...

Select incremental-upgrade-12.2.0.0.0_61.1.0 150

4. When the confirmations message displays, click OK.

Within a few seconds, the Up to Date column transition from Y (meaning up-to-
date) or N (meaning needs upgrade).

= Name Alarm Severity | Up to Date | Server Role | Running Release
E [J cmPp site1 Cluster (2 Servers)
guam-cmp-1b N Standby 12.1.1.0.0_14.1.0
guam-cmp-1a N Active 12.4.1.00_14.1.0

11. []

CMP GUI: Upgrade
Primary CMP cluster

NOTE: This takes
approximately 30
minutes to
complete.

1. Navigate to Upgrade = Upgrade Manager.

2. (Optional) Click Filter and enter CMP in the Name field.

Upgrade Manager

Current 130: incremental-upgrade-12.2.0.0.0 61.1.0

Start Rolback  Start Upgrade Wiew Upgrade Log B Fiter Columns +  Advanced
= Name Alarm Severity | Upto Date | Server Role | Running Release Upgrade Operation
ewe ]| 3 ) = | I

E [J cMP Site1 Cluster (2 Servers)

guam-cmp-1b N Standby 12.1.1.0.0_14.1.0 nia

guam-cmp-1a N Active 12.1.1.00_14.1.0 nia

3. Select the checkbox for the Primary CMP Server cluster

4. Click Start Upgrade.

StartRollback  Start Upgrade

5 |Name Initiate upgrade CMP-2 (next) | [ ypio | server R

i B | —

feme i

| E [ CMP Site1 Cluster (2 Servers)
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5. Click OK to confirm and continue with the operation.
This continues to upgrade the standby server only in the CMP cluster

The Upgrade Operation column shows a progress bar along with the upgrade
activities.

Upgrade Operation

Intiate upgrade :: Upgrading server (Elapsed Time: 0:0...

| Initiate upgrade Completed Succsssfully at Sep 18, 2015 14:10-18

Upgrade Operation changes to completed when done.

During the upgrade activities, the following alarms may be generated and
considered normal reporting events.

Expected Critical alarm

31283 Lost Communication with server

31227 HA availability status failed

70025 QP Slave database is a different version than the master
70001 QP_procmgr failed

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Database replication Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31114 DB replication over SOAP has failed
31282 HA Management Fault

Upgrade is complete on the standby server of the CMP cluster when the Initiate
upgrade Completed successfully at... message displays in the Upgrade Operation

column.
Start Rollback Continue Upgrade View Upgrade Log D Fitter Columns +  Advanced «
Name Alarm Severity | Up to Date | Server Role | Running Release | Upgrade Operation
crp [N N N | N
| = CMP Site1 Cluster (2 Servers)
guam-cmp-1b (&) Critical Y Standby 12.2.0.0.0_51.1.0 ' ') Initiate upgrade Completed Successfully at Now 9, ...
guam-cmp-1a & Minor N Active 12.1.1.0.0_141.0 n/a
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12. [] | CMP GUI: Verify 1. Navigate to Upgrade = Upgrade Manager
that the upgrade is

2. View the cluster.
successful

3. Verify the following information:
- The standby serveris on 12.3
- The other server in the cluster is on 12.2.x
- The Up to Date column shows Y for the 12.3 server and N for the 12.0

server.
Start Rollback Continue Upgrade View Upgrade Log D Fitter Columns +  Advanced «
Name Alarm Severity | Up to Date | Server Role | Running Release | Upgrade Operation

(SR || N | N | 5 || I

| = CMP Site1 Cluster (2 Servers)

guam-cmp-1b (&) Critical Y Standby 12.2.0.0.0_51.1.0 ' ') Initiate upgrade Completed Successfully at Now 9, ...

guam-cmp-1a £y Minor N Active 12.1.1.0.0_141.0 ' nia

13. [] | CMP GUI: Continue | 1. Navigate to Upgrade > Upgrade Manager.

to upgrade CMP 2. Select the checkbox for the Primary CMP Server cluster

cluster
3. Click Continue Upgrade. Notice the Failover to new version CMP Sitel Cluster
message.
Start Rollback Continue Upgrade View Upgrade Log LD Fitter Columns +  Advanced «
Mame Failover to new version CMP Site1 Cluster (next) iz | Upgrade Operation

(ST || N £ ] N |} I

| = CMP Site1 Cluster (2 Servers)

guam-cmp-1b X Critical Y Standby 12.2.0.0.0_81.1.0 '+ Initiate upgrade Completed Successfully at Nov 9, ...

guam-cmp-1a £y Minor N Active 12.1.1.0.0_141.0 ' nfa

4. Click OK to confirm and continue with the operation.

The specific action take approximately a minute to complete.

14. [] | CMP GULI: Login to Close the current CMP GUI browser tab and reopen another browser tab with the
the CMP server VIP same CMP VIP address.

The Policy Management release 12.3 CMP GUI login form should appear as
shown—Ilogin and password credentials are the same as the pre-upgrade.

ORACLE’
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15. [_] | CMP GUI: Verify Navigate to Help=>About. Verify the release displayed is 12.3
new Policy
12.2.0.0.0_65.1.0
Management
Copyright (C) 2003, 2017 Oracle. All Rights Reserved.
release

16. []

CMP GUI: Critical
alarms

Critical alarm 70025, QP Slave database is a different version than the master, is
seen until the SQL Database matches the master (12.3). This alarm is expected and
remains until all CMP servers are upgraded to the same version.

Current Critical Alarms

70025 QP Slave database is a different version than the master:

3 Alarms found, displaying all Alarms.

Occurrence Severity = Alarm ID Text

Sep 28, 2015 07:44 PM EDT 70025 The MySQL slave has a different schema version than the master.
Sep 28, 2015 07:44 PM EDT 70025 The MySQL slave has a different schema version than the master.
Sep 28, 2015 07:44 PM EDT 70025 The MySQL slave has a different schema version than the master.

Current Minor Alarms

70503 Server Forced Standby
70500 System Mixed Version
70501 Cluster Mixed Version

3 Alarms found, displaying all Alarms.

Occurrence Severity | Alarm ID Text

Sep 26, 2015 07:43 PM EDT Minor 70503 The server is in forced standby

Sep 28, 2015 07:43 PM EDT Minor 70501 The Cluster is running different versions of software
Sep 26, 2015 07:43 PM EDT Minor 70500 The system is running different versions of software

NOTE: The Upgrade Manager shows alarms as well.

17. []

CMP GUI: Verify the
Policy Management
release 12.3 CMP is
Active

1. Navigate to Upgrade=> Upgrade Manager.
2. Verify the following

- Active server is running releasel2.3

- Standby server is on the previous release
= MName Alarm Severity | Up to Date | Server Role Running Release Upgrade Operation
= D CMP Site1 Cluster (2 Servers)

guam-cmp-1b % Minor A4 Active 12.2.0.0.0_61.1.0 +') Initiate upgrade Completed Successfully at Nov 8, 2...
guam-cmp-1a (%) Critical N Standby 12.1.1.0.0_14.1.0 n'a
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18. [ ] | CMP GUI: Complete | 1. Navigate to Upgrade - Upgrade Manager.

the upgrade of the .

. P& 2. Select the checkbox for the Primary CMP Server cluster
Primary CMP cluster

- 3. Click Continue Upgrade. Notice the message Initiate upgrade <standbyserver>

NOTE: Remaining (next) when hov:rgin over the button ; e ’
CMP server takes & '
approximately 30 Current 150: incremental-upgrade-12.2.0.0.0 61.1.0
minutes to Start Rollback Continue Upgrade Wiew Upgrade Log L Fiter Columns =+ Advanced «
comp|Ete. Bl | Name Initiate upgrade guam-cmp-1a (next) | running Rekease Upgrade Operation

= CMP Site1 Cluster (2 Servers)

guam-cmp-1b &% Minor Y Active 12.2.0.0.0 61.1.0 +) Initiate upgrade Completed Successfully at Mov 9, 2016 1.

guam-cmp-1a @ %) Critical N Standby 12.1.1.00_141.0 n/a

4.

Click OK to continue the upgrade on the remaining server in the CMP cluster

NOTE: The server that is being upgraded goes into an OOS state.

Expected Critical Alarms

31227 HA availability status failed

31283 Lost Communication with server

70001 QP_procmgr failed

70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault
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19. [_] | CMP GUI: Tracking 1. Navigate to Upgrade - Upgrade Manager.
the upgrade

The last step in the upgrade for the first CMP cluster is to wait for replication
complete

to complete.

2. With the CMP cluster checkbox still selected, click View Upgrade Log. A
window opens where you can verify that synchronization has taken place:

Upgrade Log

te: 11710720 00

1D Parent 1D | Action Hame Duration | Scope Hostname Result Mode

1 0 Preflight Check 0:00:15 Server guam-cmp-1b Success Manual

2 1 Upgrading server :22:00 Server guam-cmp-1t Success Automatic
3 1 Modify the role/replication attributes of the server @ 0:00:01 Cluster CMP Site1 Cluster | Success Automatic
4 1 Wait for replication to synchronize 0:00:09 Server guam-cmp-1k Success Automatic
5 0 Failover fo new version 0:00:00 Cluster CMP Site1 Cluster = Success Manual

6 0 Preflight Check 0:00:15 Server guam-cmp-1a Success Manual

7 3 Upgrading server 0:21:50 Server guam-cmp-1a Success Automatic
8 ] Modify the role/replication attributes of the server - 0:00:01 Cluster CMP Site1 Cluster | Success Automatic
9 6 Vatt for replication to synchronize 0:00:28 Server guam-cmp-1a Success Automatic
10 6 Modify the rolefreplication attributes of the server @ 0:00:01 Cluster CMP Site1 Cluster | Success Automatic

20. [_] | CMP GUI: Verify the | Navigate to Upgrade Manager - Upgrade Manager.

status of upgraded

E | Name Alarm Severity | Up to Date | Server Role | Prev Release Running Release | Upgrade Operation

CMP server.
| =] CMP Site1 Cluster (2 Servers)

guam-cmp-1t © 4 Kinor Y Active 12.1.1.0.0_141.0 122000_51.1.0 '+ Inttiate upgrade Completed Successfully at

guam-cmp-1a A Standby 12.1.1.0.0_14.1.0  12.2.0.0.0_51.1.0 '+ Initiate upgrade Completed Successfully at...

Successful upgrade status shows the following for both servers in the Primary CMP
cluster:

e 12.3in the Running Release column for both servers
e AYinthe Up to Date column

e Active or Standby state for both servers in the Primary CMP cluster.

21. [ ] | Proceed to next Verify the following information:

upgrade procedure
Pe P e  Primary Sitel is running release 12.3

e Secondary Site is on release 12.2.x

e Proceed to the next procedure to upgrade the secondary CMP cluster.

---End of Procedure---
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5.1.2 Upgrade Secondary CMP Cluster

Step Procedure Details
1. [] | €MP GUL: Verify 1. Navigate to Upgrade - Upgrade Manager.
status of CMP cluster .
2. Verify that:
- Primary CMP is completely upgraded to 12.3
- Secondary CMP cluster is on 12.2.x
= Name Alarm Severity | Up to Date | Server Role | Running Releaze | Upgrade Operation
| = CMP Site1 Cluster (2 Servers)
guam-cmp-1b £ Minor Y Active 12.2.0.0.0_51.1.0 - '+’ Initiate upgrade Completed Successfully at
guam-cmp-1a Y Standby 12.2.0.0.0_81.1.0 : '+JInitiate upgrade Completed Successfully at
B [ cmP site2 Cluster (2 Servers)
guam-cmp-2a X Critical M Active 121.1.0.0_141.0 : nfa
guam-cmp2b *) Critical N Standby 12.1.1.0.0_14.1.0 : nia
2. [] | CMP GUI: Upgrade 1. Navigate to Upgrade - Upgrade Manager.
Secondary CMP . . . . )
4 2. (Optional) Click Filter and enter CMP in the Name field.
cluster
Current IS0- standard-upqrade-12.1.2.0.0 2240
NOTE: ThlS ta keS StartRollbeck St Upgrace VewlUpgadtlog  BFfer Coumse  Advanced v
approximately 30 8 Juse /
minutes to complete. ee JL _ECH ol It o]
3. Select the checkbox for the Secondary CMP Server cluster at Site2
4. Click Continue Upgrade. When hovering over the button, it reads Initiate
upgrade <site2_standbyserver> (next)
Start Rollback Continue Upgrade View Upgrade Log A Fitter
E | Name Initiate upgrade guam-cmp2b (next) = | Running Release | Upgrade Operation
[ E[ EC =W
El ] cMP site1 Cluster (2 Servers)
guam-cmp-1b 4y Minor Y Active 12.2.0.0.0_61.1.0 +") Initiate upgrade Completed Successfully at
guam-cmp-1a Y Standby 12.2.0.0.0_81.1.0 +")Initiate upgrade Completed Successfully at
= CMP Site2 Cluster (2 Servers)
guam-cmp-2a X! Critical N Active 12.1.1.0.0_14.1.0 nia
guam-cmp2b X Critical N Standby 121.1.0.0_1410  nfa
5. Click OK to confirm and continue with the operation.
This continues to upgrade the standby server only in the CMP cluster
The Upgrade Operation column shows a progress bar along with the upgrade
activities.
Upgrade Operation
Inttiate upgrade :: Upgrading server (Elapsed Time: 0:0...
+") Initiate upgrade Completed Successfully at Sep 18, 2015 14:10:18.
During the upgrade activities, the following alarms may be generated and
considered normal reporting events:
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Expected Critical alarm

31283 Lost Communication with server
70001 QP_procmgr failed
70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

Upgrade is complete on the standby server of the Site2 CMP cluster when the
Initiate upgrade Completed successfully at... message displays in the Upgrade
Operation column.

| = CMP Site2 Cluster (2 Servers)

guam-cmp-2a ) Critical N Active 12.1.1.0.0_141.0  nia

guam-cmp2b Y Standby 12.2.0.0.0_61.1.0 +"! Initiate upgrade Completed Successfulty at |
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Step Procedure Details
3. [] | CMP GUL: Failover of | 1. Navigate to Upgrade - Upgrade Manager.
the Secondary CMP

cluster 2. Select the checkbox for the Secondary CMP Server cluster at Site2

3. Click Continue Upgrade. Notice the message ‘Failover to new version CMP
Site2 Cluster’

Start Rollback Continue Upgrade View Upgrade Log LD Fitter

Elmalsblame: Failover to new version CMP Site2 Cluster (next) ase | Upgrade Operation

S N = | N N | I

Bl [ cmP site1 Cluster (2 Servers)
guam-cmp-1b ¢ /% Winor Y Active 122.0.0.0_61.1.0 +') Initiate upgrade Completed Successfully at

guam-cmp-1a Y Standby 12.2.0.0.0_61.1.0 +') Initiate upgrade Completed Successfully at

= CMP Site2 Cluster (2 Servers)

guam-cmp-2a %) Critical N Active 121.1.0.0_141.0 nla

guam-cmpZb Y Standby 122.0.0.0_61.1.0 +') Initiate upgrade Completed Successfully at

4. Click OK to confirm and continue with the operation.

The failover takes about a minute to complete. Wait until the upgraded
server is active, running 12.2 as shown below.

Start Rollback Continue Upgrade View Upgrade Log D Fitter

= Name Alarm Severity | Up to Date | Server Role | Running Release Upgrade Operation

(ZAr S I N ) N | I

El ] cMP site1 Cluster (2 Servers)
guam-cmp-1b /2% Winor Y Active 122.0.0.0_61.1.0 +’) Initiate upgrade Completed Successfully at

guam-cmp-1a Y Standby 12.2.0.0.0_61.1.0 +’) Initiate upgrade Completed Successfully at

= CMP Site2 Cluster (2 Servers)

guam-cmp-2a %) Critical M Standby 12.1.1.0.0_141.0 nia

guam-cmp2b Y Active 12.2.0.0.0_61.1.0 +’) Initiate upgrade Completed Successfully at
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4. []| CMP GULI: Continue 1. Select the checkbox for the Secondary CMP Server cluster at Site2
szscggizirofcﬂl\]/TP 2. Click Continue Upgrade. When hovering over the button, the message
cluster ¥ displays the next action, which is upgrading the remaining CMP in standby,

still running 12.2.x.

Start Rollback Continue Upgrade

E | Name Initiate upgrade guam-cmp-2a (next) | Running Release

(2N N 2 | N = ) N £ |

Bl ] cMP site1 Cluster (2 Servers)

View Upgrade Log L Fitter

Upgrade Operation

guam-cmp-1b 4% Minor Y Active 12.2.0.0.0_61.1.0 +") Initiate upgrade Completed Successfully at

guam-cmp-1a Standby 12.2.0.0.0_81.1.0 «") Initiate upgrade Completed Successfully at
| = CMP Site2 Cluster (2 Servers)

guam-cmp-2a %! Critical M Standby 12.1.1.0.0_141.0 nfa

guam-cmp2b h Active 12.2.0.0.0_61.1.0 +"! Initiate upgrade Completed Successfully at

3. Click OK to confirm and continue with the operation.

During the upgrade activities, the following alarms may be generated and

considered normal reporting events.

Expected Critical alarm

31283 Lost Communication with server
70001 QP_procmgr failed

70025 QP Slave database is a different version than the master

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault
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Step

Procedure

Details

5.

[

CMP GUI: Verify that
the upgrade
completed
successfully.

Upgrade = Upgrade Manager

Successful upgrade status shows release 12.3 in the Running Release column and

the Upgrade Operation.

The Upgrade Operation column shows Initiate Upgrade Completed Successfully

at... with the correct date and time.
Start Rollback Start Upgrade

= Name Alarm Severity | Up to Date | Server Role

S B N N | I

B O cmP sitet Cluster (2 Servers)
guam-cmp-1b © 4 Winor Y Active

guam-cmp-1a A Standby

Running Releaze

122.0.0.0_61.1.0
122.0.0.0_61.1.0

View Upgrade Log D Fitter

Upgrade Operation

+) Inttiate upgrade Completed Successfully at

+) Inttiate upgrade Completed Successfully at

= CMP 5ite2 Cluster (2 Servers)

guam-cmp-2a Y Standby 12.2.0.0.0_61.1.0 +") Initiate upgrade Completed Successfully at
guam-cmp2b Y Active 12.2.0.0.0_61.1.0 +"! Initiate upgrade Completed Successfully at
6. [ ]| CMP GUI: Verify Navigate to System Wide Reports = Alarms = Active Alarms.
alarms
Expected Minor Alarms
70500 System Mixed Version
7. [] | Procedureis Verify the following information:

complete.

e  All CMP clusters upgrades are complete and running release 12.3

e All MRA and MPE clusters are running release 12.2.x

e The Policy Management system is running in mixed-version mode.

---End of Procedure---
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Software Upgrade Procedure

6. UPGRADE NON-CMP CLUSTERS (MPE, MRA) 12.2.X/12.2.X WIRELESS MODE
The following procedures upgrades a site/segment containing one or more MPE, MRA clusters.

NOTES:
e An upgrade of up to 4 clusters (8 for 12.2.x) can be running at the same time.

e Different cluster types can be upgraded at the same time. 2 MPEs and 2 MRAs, for example, can be
upgraded in parallel.

6.1 Upgrade Preparation

6.1.1 Configuration Preparation

Step Procedure Result
1. |:| CMP GUI: Access into Use the supported browser to login as the admin user or as a user with
CMP server administrative privileges.

2. |:| CMP GUI: Verify current 1. Navigate to Upgrade = Upgrade Manager.
Upgrade Manager status
and software release 12.3
ISO files 3. Verify that all MPE and MRA clusters have an Active, Standby, and Spare
server.

2. Verify that all CMP clusters have both Active, Standby status.

4. Verify that Policy Management release 12.3 ISO files are available for all
MPE, and MRA clusters. One ISO per server

5. Verify that the CMP cluster is upgraded successfully and running Policy
Management release 12.3

---End of Procedure---
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6.2 Upgrade MRA and MPE Servers

This procedure upgrades one or more clusters (MPE and/or MRA).

This procedure is applicable for 12.2.x (wireless mode) or 12.2.x upgrade to 12.3.

This section can be replicated for each site/segment to be upgraded, allowing you to add cluster and site

specific

information.

The upgrade procedure is essentially the same for an MRA cluster and an MPE cluster.

1. Select and start upgrade on the standby server
2. Failover
3. Re-apply configuration
4. Continue to upgrade the spare server
5. Continue upgrade on remaining server
6. (MPE only) Re-apply configuration one MPE cluster at a time
NOTES:
e All CMP clusters must be upgraded to Policy Management release 12.3 prior to executing the
following procedures.
e  Four (4) clusters (8 for 12.2.x) can be running the upgrade at one time.
e Only ONE cluster can be selected for upgrade activity, bulk selection of servers is not supported in
release 12.3.
Step Procedure Result
1. [] | CMP GUI: Health Perform the following:
ﬁz]sgl/(liﬂc;(lt:eervers to 1. Check for current active alarms

be upgraded 2. Reset MPE/MRA counters to make a baseline
- For the MPE: Policy Server->Configuration=><server_name>=>Reports
- Reset Counters

- For the MRA: MRA->Configuration><server_name>->Reports = Reset
Counters

3. Gotothe KPI Dashboard and capture a screenshot.

System Wide Reports = KPI Dashboard
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2. [] | CMP GUI: Verify 1. Navigate to Upgrade = Upgrade Manager.
upgrade status of

selected MPE/MRA
site/segment e Current release 12.2.x, or 12.2.x installed

2. Verify information for the MRA/MPE servers:

e Active/Standby/Spare status

e ISO version to be deployed is 12.3 (verify the current ISO files are
12.3 by going to Upgrade—> ISO Maintenance)

= 0 guam-mpe-1 MPE
D guam-mpe-1a MPE encl701 10.240.152.79 12.1.1.0.0_14.1.0 DVT\DE'IE.E.D.D.D_EI.I.D'XE5_54.ISD[IDDD/L|]
[ guam-mpe-1b MPE encl701  10.240.152.80 12.1.1.0.0_14.1.0 [ Impe-12.2.0.0.0_61.1.0-x36_64.is0[100%]
[l guam-mpe-1c MPE encl702  10.240.152.101 12.1.1.0.0_14.1.0 [Impe-12.2.0.0.0_61.1.0-x86_64.iso[100%]
= || guam-mra-1 MRA
[ guam-mra-la MRA encl701 10.240.152.77 12.1.1.0.0_14.1.0 Dmra-lz.z.U.U.U_El.l.D-xBE_EA-.\sD[lUU%]
L] guam-mra-1b MRA encl701  10.240.152.78 12.1.1.0.0_14.1.0 [Imra-12.2.0.0.0_61.1.0-x86_64.is0[100%]
I} guam-mra-1c MRA encl702  10.240.152.100 12.1.1.0.0_14.1.0 Dmra-12.2.0.0.U_El.l.D-xBE_E4.\su[lDU%]
3. |:| CMP GUI: Upgrade NOTE: Start the upgrade on ONE cluster. Wait until the cluster shows OOS, and
clusters then continue with the next cluster and so on. Up to 4 clusters (8 for 12.2.x) may

NOTE: The upgrade of be running upgrade at any time.

a single server takes 1. Navigate to Upgrade = Upgrade Manager.
apprommately 40 2. Select the checkbox for the cluster to be upgraded, it can be an MRA or MPE
minutes to complete.

3. Click Continue Upgrade

Start Rolback  Continue Upgrade

E | Name Initiate upgrade guam-mpe-1a (next) - Running Release

G N | £} N || I £

| = guam-mpe-1 (3 Servers)

guam-mpe-1c N Spare 12.1.1.0.0_14.1.0
guam-mpe-1b N Active 12.1.1.0.0_14.1.0
guam-mpe-1a N Standby 12.1.1.0.0_14.1.0

4. Click OK to confirm and continue with the operation. The upgrade of the
standby server of that cluster begins.

Wait until the cluster reports OOS before selecting the next cluster

Follow the progress in the Upgrade Operation column.

Upgrade Operation

Initiate upgrade :: Upgrading server (Elapsed Time: 0:0...

| Initiate upgrade Completed Succsssfully at Sep 18, 2015 14:10:18

During the upgrade activities, the following alarms may be generated and
considered normal reporting events.

Expected Critical Alarms

31283 HA Server Offline / Lost Communication with server
70001 QP_procmgr failed
31227 HA availability status failed

Expected Major Alarm

31233 High availability path loss of connectivity
70004 QP Processes down for maintenance
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Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31282 HA Management Fault

78001 Rsync Failed

Upgrade is complete on the first server in the cluster when the Initiate upgrade
completed successfully at... message displays in the Upgrade Operation column.
The server returns to the Standby state when the upgrade completes.

20 guam-mpe-1 (3 Servers)

guam-mpe-1c N Spare 12.1.1.0.0_14.1.0 nia
guam-mpe-1b N Active 12.1.1.0.0_14.1.0 +") Initiate backout Completed Succeszsfully at |
guam-mpe-1a Y Standby 12.2.0.0.0_61.1.0 +"! Initiate upgrade Completed Successfully at

During the upgrade activities, the following alarms may be generated and
considered normal reporting events.

Alarm 31224—HA configuration error (major) is raised noting that there is a
configuration error. This clears a few minutes after the upgrade completes on
the first server. The following minor alarms may be present:
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Expected Minor Alarms

78001 Rsync Failed

70500 System Mixed Version
70501 Cluster Mixed Version
70503 Server Forced Standby

CMP GUI: Continue to
upgrade the
MRA/MPE clusters.
Next operation is a
failover

NOTE: 4 clusters (8
for 12.2.x) can be
running the upgrade
process at one time.

Fail over ONE cluster at a time and wait until the upgraded server becomes
active before moving on to the next cluster.

1. Navigate to Upgrade - Upgrade Manager.

2. Select the checkbox for the cluster being upgraded (it can be an MRA or
MPE)

3. Click Continue Upgrade. When hovering over the button, it says Failover to
new version...

Start Rollback Continue Upgrade

B | Name Failover to new version guam-mpe-1 (next) q Release

S N | 2 N = |} I

| =l guam-mpe-1 (3 Servers)

guam-mpe-1c N Spare 12.1.1.0.0_14.1.0
guam-mpe-1b N Active 12.1.1.0.0_14.1.0
guam-mpe-1a Y Standby 12.2.0.0.0_61.1.0

4. Click OK to confirm and continue with the operation. It starts to failover the
cluster.

Wait until failover completes before failing over the next cluster, this takes a
minute or two to complete. Verify the 12.3 server is now active. The process is
complete when there is an active/standby at site 1 and spare at site 2.

20 guam-mpe-1 (3 Servers)

guam-mpe-1c & Minor N Spare 12.1.1.0.0_14.1.0
guam-mpe-1b & Minor N Standby 12.1.1.0.0_14.1.0
guam-mpe-1a & Minor Y Active 12.2.0.0.0_61.1.0
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5. []

CMP GUI: Reapply
configuration on
MPE/MRA cluster that
completed the
upgrade successfully.

e For MPE: PolicyServer = Configuration = <MPE_cluster_name> => System
e  For MRA: MRA->Configuration><MRA_cluster>->System

The selected cluster shows a status of Degraded as it has different releases for
the Active and Standby servers. It may display Config mismatch as well. This is

expected.

1. Click Reapply Configuration

Em o o R e e

NOTE: A progress bar displays for the MPE reapply configuration only. The
MRA reapply configuration does not display the progress bar.

Reapply Settings to the RC

Re-applying Settings to the RC...

Applying Configuration to Policy Server : 18 i 54 3

2. Note the version is successfully changed to the upgraded release 12.3.

NOTE: The status shows as Degraded as the servers are still in different releases.

Policy Server: guam-mpe-1

@ Reports T Logs T Policy Server T Diameter Routing

Modify Delate Reapply Configuration
The configuration was applied successfully.
Configuration
MName guam-mpe-1
Status

Version 12.2.0.0.0_61.1.0
Description / Location

Secure Connection No

Legacy No

Type Oracle

Systemn Time Mowv 10, 2016 12:55 PM EST
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6.

[

CMP GUI: Current
alarms

During the upgrade activities, the following alarms may be generated and
considered normal reporting events.

Expected Critical alarm

None

Expected Major Alarm

78001 Rsync Failed

Expected Minor Alarms

70503 Server Forced Standby

70502 Cluster Replication Inhibited

70500 System Mixed Version

70501 Cluster Mixed Version

71402 Connectivity Lost

31101 Database replication to slave failure

7. [] | CMP GULI: Verify 1. Navigate to Upgrade Manager = System Maintenance.
tr?fﬁ.c becomgs active - If traffic is active, go to step 9.
within approximately
90 seconds - If traffic does not become active within 90 seconds:
2. Select the checkbox for the partially upgraded cluster, and select Operations
- Rollback.
The pre-12.2 MPE server becomes the active server and resumes handling traffic.
8. [] | CMP GUI: Reapply 1. Policy Server 2> Configuration > <mpe_cluster name> > System tab
configuration or
MRA - Configuration > <mra_cluster name> > System tab
2. Click Reapply Configuration
3. Verify that the version is changed back to 10.5, 11.5, 12.0, or 12.1.1, and the

action report success.

If NOT, stop and contact Oracle support to back out of the partially upgraded
cluster.

60

E85338-01



https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_alarm_70503.html?resultof=%22%37%30%35%30%33%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_alarm_70500.html?resultof=%22%37%30%35%30%30%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_alarm_70501.html?resultof=%22%37%30%35%30%31%22%20
https://100.64.181.62/infocenter/topic/m_cpm_troubleshooting/tasks/t_cpm_comcol_alarm_31101.html?resultof=%22%33%31%31%30%31%22%20

Software Upgrade Procedure

Step Procedure
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9. [] | CMPGUI: 78001
Major Alarm

During the upgrade activities, Major alarm 78001 in particular may be generated.
And even though it is a normal event, the alarm does not clear by itself. Before
continuing ensure that the alarm is cleared.

1. Click Major in the upper right part to display the alarms:

il% :45 PM | admin | Logout

2. Click the binoculars icon on the right to display details about the 78001
Major alarm

Dccurrence Severity | Alarm ID Text OAM VIP Server

. . N . perf-mpe-b
Jan 05, 2017 04:19 PM EST Major 78001 Transfer of Policy jar files failed 10.240.166.37 H

You should see in the last line of the details that the reason for the major
alarm is Version check failed.

Date/Time Jan 05, 2017 04:19 PM EST

Severity Major
Text Transfer of Policy jar files failed
Count 1
First Jan 05, 2017 04:19 PM EST
Occurrence
Last
as Jan 05, 2017 04:19 PM EST
Occurrence
Server porf-mpe-b,10.240.166.37
Details RSYMNC: Policy jar files sync to standby failed.

Reason: Version check failed

Cancel

- If you see a different reason, stop and contact My Oracle Support.
- If you see the Version check failed reason, continue to the next step.

3. Navigate to System Wide Reports = Alarms => Active Alarms and select the
78001 Major alarm

perf-mpe-b
10.240.166.37

MPE Major 78001 5m 355/ --- Transfer of Policy jar files failed 01/05/2017 16:19:53 EST O'ﬁ |

4. Click the trash can icon on the right to clear this alarm.

CMP GUI: Continue
upgrade of the
MRA/MPE clusters.
Next operation is
initiate upgrade on
the Spare server

10. []

Continue the upgrade on ONE cluster first, when the server goes into O0S,
continue with the next cluster and so on.

NOTE: Up to 4 clusters (8 for 12.2.x) can be running the upgrade process at one
time.

1. Navigate to Upgrade = Upgrade Manager.
2. Select the checkbox for a cluster.

- Select one cluster at a time
- Can be an either an MRA or MPE cluster

3. Click Continue Upgrade. When hovering over the button, it reads Initiate
upgrade... on the spare server
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Step Procedure Result
Start Rollback Continue Upgrade
E | Name Initiate upgrade guam-mra-1c (next) jq Running Release
[ I = =] | []
| = guam-mra-1 (3 Servers)
guam-mra-1c N Spare 12.1.1.0.0_14.1.0
guam-mra-1b N Standby 12.1.1.0.0_14.1.0
guam-mra-1a Y Active 12.2.0.0.0_61.1.0
4. Click OK to confirm and continue with the operation.
Wait until the cluster reports OOS before selecting the next cluster
Follow the progress in the Upgrade Operation column.
Upgrade Operation
Initiate upgrade :: Upgrading server (Elapsed Time: 0.0...
) Initiate upgrade Completed Successfully at Sep 18, 2015 14:10:18
During the upgrade activities, the following alarms may be generated and
considered normal reporting events—these are cleared after the MPE cluster is
completely upgraded.
Expected Critical Alarms
31283 HA Server Offline / Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed
Expected Major Alarm
70004 QP Processes down for maintenance
Expected Minor Alarms
70503 Server Forced Standby
70507 Upgrade In Progress
70500 System Mixed Version
70501 Cluster Mixed Version
70502 Cluster Replication Inhibited
Upgrade is complete on the spare server in the georedundant cluster when:
e The Initiate upgrade Completed Successfully... message displays in the
Upgrade Operation column.
e The server goes back to the Spare state.
e The Up to Date column shows a Y (YES).
The Active and Spare servers are on release 12.3 and the current Standby is on
the previous release
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=20 guam-mpe-1 (3 Servers)

guam-mpe-1c Y Spare 12.2.0.0.0_61.1.0
guam-mpe-16 N Standby 12.1.1.0.0_14.1.0
guam-mpe-1a %) Major Y Active 12.2.0.0.0_61.1.0

20d guam-mra-1 (3 Servers)

guam-mra-1c Y Spare 12.2.0.0.0_61.1.0
guam-mra-1k N Standby 12.1.1.0.0_14.1.0
guam-mra-1a b Active 122.0.0.0_61.1.0

11. [] | €MP GUL: Continue to | Continue the upgrade on ONE cluster first, when the server goes into OOS,
upgrade the continue with the next cluster and so on. Up to 4 clusters (8 for 12.2.x) may be
MRA/MPE clusters. running the upgrade at one time.

Next operation is
Initiate upgrade on
the standby server 2. Select the checkbox for a cluster

1. Navigate to Upgrade - Upgrade Manager.

- Select one cluster at a time
- Can be an either an MRA or MPE cluster

3. Click Continue Upgrade. When hovering over the button, the message
displays the next action, which is to initiate the upgrade of the standby
server.

Start Rollback Continue Upgrade

2 | name Initiate upgrade guam-mra-1b (next) | Running Release

(SN S | N || NN I

| = guam-mra-1 (3 Servers)

guam-mra-1c b Spare 122.0.0.0_61.1.0
guam-mra-1b N Standby 12.1.1.0.0_141.0
guam-mra-1a Y Active 12.2.0.0.0_61.1.0

4. Click OK to confirm and continue with the operation. The final server
upgrade of the cluster begins

Wait until the cluster reports OOS before selecting the next cluster

Follow the progress in the Upgrade Operation column.

Upgrade Operation

Initiate upgrade :: Upgrading server (Elapsed Time: 0:0...

| Initiate upgrade Completed Succsssfully at Sep 18, 2015 14:10:18

During the upgrade activities, the following alarms may be generated and
considered normal reporting events—these are cleared after the MPE cluster is
completely upgraded.

Expected Critical Alarms

31283 HA Server Offline / Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed

Expected Major Alarm

70004 QP Processes down for maintenance

63 E85338-01




Software Upgrade Procedure
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Result

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled

Upgrade is complete on the third server in the georedundant cluster when:

e The completed successfully message shows in the Upgrade Operation
column.

e The server goes back to the Standby state.

e The Up to Date column shows a Y (YES)

=20 guam-mra-1 (3 Servers)

guam-mra-1c Y Spare 12.2.0.0.0_61.1.0 | v Initiate upgrade Completed Successfully at
guam-mra-1b Y Standby 12.2.0.0.0_81.1.0 | ¥ Inttiate upgrade Completed Successfully at
guam-mra-1a Y Active 12.2.0.0.0_61.1.0 : v Inttiate upgrade Completed Successfully at

All servers are now running release 12.3

12. [] | €MP GUI: (MPE only)
Reapply configuration
on the fully upgraded
MPE clusters.

MPE only
1. Navigate to PolicyServer = Configuration = <MPE_cluster> => System.
2. Click Reapply Configuration

NOTE: A progress bar displays for the MPE reapply configuration.

Reapply Settings to the RC

Re-applying Settings to the RC...
Applying Configuration to Policy Server : 18 18 84

13. [ ] | Repeat steps 1
through 14 for the

next MPE or MRA
cluster

Proceed with next cluster
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14. [ ] | Upgrade Completed At this point all servers have been upgraded.

= Name Alarm Severity | Up to Date | Server Role | Prev Release Running Release Upgrade Operation
=[] cmP Site1 Cluster (2 Servers)
guam-cmp-1b Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_81.1.0 ) Initiate upgrade Completed Successfully at
guam-cmp-1a Y Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_81.1.0 ) Initiate upgrade Completed Successfully at
= |:| CMP Site2 Cluster (2 Servers)
guam-cmp-2a Y Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0 +) Initiate upgrade Completed Successfully at
guam-cmp2b Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0 + Initiate upgrade Completed Successfully at

= |:| guam-mpe-1 (3 Servers)

guam-mpe-1c Y Spare 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0 + Initiate upgrade Completed Successfully at
guam-mpe-1b Y Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0 +) Initiate upgrade Completed Successfully at
guam-mpe-1a Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_81.1.0 +) Initiate upgrade Completed Successfully at

=20 guam-mra-1 (3 Servers)

guam-mra-1c Y Spare 12.1.1.0.0_14.1.0 12.2.0.0.0_81.1.0 +) Initiate upgrade Completed Successfully at
guam-mra-1b Y Standby 121.1.0.0_14.1.0 12.2.0.0.0_81.1.0 +) Initiate upgrade Completed Successfully at
guam-mra-1a Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_81.1.0 +) Initiate upgrade Completed Successfully at

---End of Procedure---
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7. POST UPGRADE HEALTH CHECK

NOTE: This section is used when the entire topology is running release 12.3

Step Procedure Result

1. [] | €CMP GUL: Verify the 1. Navigate to Upgrade = Upgrade Manager.
upgrade is successful
on all CMP/MA/MPE/
Mediation clusters.

2. View the Up to Date, Running Release, and Upgrade Operation columns
and verify that they read Y, 12.2...,, and Initiate upgrade completed
successfully at... respectively, for all servers in all clusters.

Start Rolback  Start Upgrade

B | Name Alarm Severity | Upto Date | Server Role | Prev Release Running Release Upgrade Operation
£ [0 BoD (2 servers)
BOD-B ¥ Standby 1150.0.0_39.1.0 122000 32.1.0 /) Iniiate upgrade Completed Successfully at Nov 10, 2016 9:54:50.
BOD-A ¥ Active 115000 32.1.0 12200.0_32.1.0 /) Inttiate upgrade Completed Successfully at Nov 10, 2016 9:27:10.
= [J CMP Site1 Cluster (2 Servers)
Site1-CMP-A ¥ Active 1150.0.0_39.1.0 1220003210 /) Intiate upgrade Completed Successfuly at Nov 2, 2016 18:52:01.
S1e1-CMP-B ¥ Standby 1150.0.0.39.1.0 1220003210 /) Infiate upgrade Completed Successfully at Nov 2, 2016 18:52:01
2 [0 ™A (2 Servers)
maB ¥ Standby 1150.0.0_39.1.0 1220003210 /) Intiate upgrade Completed Successfully at Nov 8, 2016 13:43:18.
MA-A ¥ Active 1150.0.0_39.1.0 12.2000_32.1.0 /) Iniiate upgrade Completed Successfuly at Nov 8, 2016 13:03:48.
= [0 MPER (2 Servers)
WPE-R-E ¥ Active 1150.0.0.39.1.0 1220003210 /) Infiate upgrade Completed Successfuly at Nov 8, 2016 23:30:18.
WMPE-RA ¥ Standby 1150.0.0_39.1.0 122000 32.1.0 /) Iniiate upgrade Completed Successfuly at Nov 9, 2016 7:13:48.
E [ MPE-$ (2 servers)
WMPE-S-A ¥ Standby 1150.0.0_39.1.0 122000 32.1.0 /) Iniiate upgrade Completed Successfuly at Nov 9, 2016 11:50:50.

MPE-5-B v Active 1.5.0.0.0_38.1.0 122.00.0_32.1.0 ) Iniiate upgrade Completed Successfully at Nov 9, 2016 11:18:58.

2. [] | CMPGUL: View current | 1. Navigate to System Wide Reports>Alarms—>Active Alarms
alarms 2. Verify that all alarms due to the upgrade have been cleared.

1160832 admin Logon

i |
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3. [] | CMPGUL: View current | 1. Navigate to System Wide Reports=>KPI Dashbord.

KPls 2. Verify that everything looks normal.

KPI Dashboard { Last Refresh:11/10/2016 10:32:34 )
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4. [] | CMP GUI: Replication 1. Navigate to System Wide Reports=>Others> MPE/MRA Rep Stats (for a
stats wireless system)

2. Verify all clusters and servers are in OK state.

Cluster Name Server Type |Cluster State| Blade State = Sync State D':Iatil(i;aizi:l;;c
= guam-mpe-1 MPE ) OK 0:0.504
guam-mpe-1b (Active) ->guam-mpe-1a (Standby) MPE ¥ OK ) oK 0:0.504
guam-mpe-1b {Active) -=>guam-mpe-1c (Spare) MPE ) OK W) OK 0:0.499
[z guam-mra-1 MRA ) OK L L 0:0.5
guam-mra-1b (Active) ->guam-mra-1a (Standby) MRA ¥ OK ) oK 0:0.498
guam-mra-1b (Active) -=guam-mra-1c (Spare) MRA ¥ OK ) oK 0:0.5

---End of Procedure---
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8. BACKOUT (ROLLBACK) 12.2.X/12.2.X WIRELESS MODE

This procedure is executed if an issue is found during the upgrade, as well as post-upgrade which impacts
network performance.

The Policy system is backed out to the previous release.

Oracle strongly recommends consulting My Oracle Support before initiating the backout procedure. They
determine the appropriate course of recovery options.

8.1Backout Sequence

The backout sequence order is the reverse of the upgrade order. The following is the overall backout
sequence:

1. Back out the non-CMP clusters (from both Sitel and Site2, if applicable)
2. Back out the Secondary CMP cluster (if applicable)
3. Back out the Primary CMP cluster

During a backout, it is important to control what version of the software is currently active. This control
needs to be maintained even if there are unexpected failures.

NOTE: In the case of a non-CMP clusters, the upgrade/backout is NOT complete until the operator performs
a Reapply Configuration from the CMP. The MRA/MPE can still operate, but may not be fully functional.
8.2Pre-requisites

1. No new policies or features have been configured or executed on the upgraded release.

2. The CMP cluster cannot backout if other non-CMP Policy servers are still on the upgraded release.

8.3Backout of Fully Upgraded Cluster

Prior to executing this procedure, Oracle recommends first consulting My Oracle Support to discuss the
next appropriate course of actions.

This procedure is used to backout a cluster that has been fully upgraded. At the end of this procedure, all
servers of the target cluster are on a pre-12.2 release with Active, Standby, or Spare status.

Expected pre-conditions:
1. The primary active CMP is on release 12.3

2. The cluster servers to be backed out are on release 12.2

8.3.1 Backout Sequence

This procedure applies to a cluster. The non-CMP cluster types (MRA, or MPE) are in georedundant mode
with active, standby and spare servers. CMP clusters may be in Sitel or Site2.

NOTE: It is possible, and desirable, to backout multiple clusters in parallel. However, in order to do this,
each cluster must start the backout procedure one at a time, staggering by about 1 minute each.
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8.3.1.1  Overview on Backout/Rollback MRA/MPE cluster

The following sequence preserves the cluster as a georedundant MRA/MPE cluster.
1. Back out of the standby server
2. Back out of the spare server
3. Fail over

4. Reapply the configuration

5

Back out of the new standby server

8.3.1.2 Backout Secondary CMP (if applicable)
NOTE: At this time, all MPEs and MRAs must already be backed out to the previous release.
Use the CMP GUI (Upgrade Manager) to backout the Secondary CMP cluster

8.3.1.3 Backout Primary CMP (12.2.x)

NOTE: At this time, all of the MPE/MRA clusters must already be backed out, the Secondary CMP must also
be backed out.

1. Use the CMP GUI (Upgrade Manager) to backout the Primary standby CMP cluster

2. Select the CMP cluster and click Rollback on the top left , would initiate backout on Standby CMP
—— e e

B Name Alarm Severity | Upto Date | Server Role Prev Release. Running Release. Upgrade Operation

| & @ cme sier cuuster 2 servers)

3. Click Continue Rollback, which would failover to older version CMP cluster.

CpgTaGC maTa g
At Mo actions are avalable for the selected cluster Gurrent 1SO: standard.uparade 12.2.0.0.0 65.1.0
Continue ﬁ%ﬂck Resume Upgrade ViewUpgradeLog ~ DFiter  Columns = Advanced =
(F:ig(vler to old version CMP Site1 Cluster 10D...| Server Role- Prev Release Running Release Upgrade Operation
a
port.cmp-b & Minor ¥ Active 115210810 122000 6510
port-emp-a % Critcal N Stanany 122000 6510 115210810 ! Iniiate backout Completed Successfully at Dec 15, 2016 154327

4. Log back in to the Primary CMP VIP

5. Use the 12.2.x System Maintenance to complete backout of the Primary CMP cluster

System Maintenance( Last Refresh :12/15/2016 16:51:00 )

[ columns =] |

Prev Running
Name Appl Type L Server State 150 Release Release
CMP Sitel Cluster CMP Sitel Cluster
perf-cmp-a CMP Site1 Cluster 10.240.166.32 Active [Jemp-12.2.0.0.0_65.1.0-x86_64.is0 17--25"1'000—5 ‘1-:-55-“—
. 11.5.2.1.0_ 12.2.0.0.0_6
perf-cmp-b CMP Sitel Cluster  10.240.166.33  Force Standby [#]emp-12.2.0.0.0_65.1.0-x86_64.is0[100%] Sl R

6. Click OK to execute Backout

Are you sure you want to execute Backout?

Cancel
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7. After rollback of CMP cluster, manually remove Forced Standby.

8. If needed, go to Policy Server = Configuration = Policy Server and click Reapply Configuration.

8.3.1.4 Backout Primary CMP (12.2.x)
Use the CMP GUI (Upgrade Manager) to backout the CMP cluster.

8.3.2 Backout of a Partially Upgraded Cluster

A partially upgraded cluster occurs when the version is not correct or the success message does not display.
If this happens, contact Oracle Support and report a partially upgraded cluster.

8.3.3 Backout Fully Upgraded MPE/MRA Cluster

Step Procedure Result
1. []| CMP GUI: Verify the 1. Navigate to Upgrade - Upgrade Manager.
status of affected )
2. Confirm status of the cluster to be backed out:
clusters
- Primary CMP is on release 12.3
- MPE/MRA is on release 12.3
- Up to Date column shows Y for all servers
EXAMPLE
= Name: Alarm Severity | Up to Date | Server Role | Prev Releaze Running Release
B [ cMP site1 Cluster (2 Servers)
guam-cmp-1b Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0
guam-cmp-1a Y Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_81.1.0
B[] cMP site2 Cluster (2 Servers)
guam-cmp-2a Y Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_81.1.0
guam-cmp2Zb Y Active 12.1.1.0.0_14.1.0 122.0.00_61.1.0
20 guam-mpe-1 (3 Servers)
guam-mpe-1c A Spare 12.1.1.0.0_14.1.0 122.0.0.0_61.1.0
guam-mpe-1b Y Standby 121.1.00_141.0  122.0.0.0_61.1.0
guam-mpe-1a Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0
20 guam-mra-1 (3 Servers)
guam-mra-1c Y Spare 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0
guam-mra-1b Y Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_81.1.0
guam-mra-1a A Active 12.1.1.0.0_14.1.0 12.2.0.0.0_81.1.0
2. []| €MP GUI: Rollback 1. Navigate to Upgrade - Upgrade Manager.
standby server—
2. Select the checkbox for the cluster.
MPE/MRA
- Select one cluster at a time.
NOTE: The backout of a
single server takes - It can be an MRA or MPE cluster.
approximately 40 3. Click Start Rollback. When hovering over the button, it informs you of
minutes to complete. the server to backout, in this case it is the current standby server.
NOTE: Up to 8 upgraded
clusters can be backed
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Step Procedure Result
out at the same time, Start Rollback  Start Upgrade View
selecting one at a time.
Initiate backout guam-mra-1b (back) pate | server Role | Prev Release Running Release
[ E[EL [ B &l
| = [v| guam-mra-1 (3 Servers)
guam-mra-1c Y Spare 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0
guam-mra-1b h Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0
guam-mra-1a Y Active 12.1.1.0.0_14.1.0 122.0.0.0_61.1.0
4. Click OK to confirm and continue with the operation. The backout
process begins.
Follow the progress in the Upgrade Operation column.
Upgrade Operation
Inttiate upgrade :: Upgrading server (Elapsed Time: 0:0...
) Initiate upgrade Completed Successfully at Sep 18, 2015 14:10:18
The server backing out goes into the OOS state and the spare server now
takes over as standby.
Wait until the server goes to an OOS state before selecting the next cluster to
backout.
During the backout activities, the following alarms may be generated and
considered normal reporting events. The alarms are cleared after the cluster
is completely backed out.
Expected Critical Alarms
31283 Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed
Expected Major Alarm
70004 QP Processes down for maintenance
78001 Rsync Failed
31233 HA Path Down
Expected Minor Alarms
70503 Server Forced Standby
70507 Upgrade In Progress
70500 System Mixed Version
70501 Cluster Mixed Version
70502 Cluster Replication Inhibited
31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
31282 HA Management Fault
Backout of this server is complete when the Initiate backout completed
successfully at... message displays in the Upgrade Operation column. The
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Step

Procedure

Result

server is running a pre-12.2 release and returns to standby with an N in the

Up to Date column.

Start Rollback Start Upgrade

= Name Alarm Severity | Up to Date | Server Role | Prev Release

Running Release

(G35 | S

[=] | [=]

=20 guam-mra-1 (3 Servers)

guam-mra-1c Y Spare 12.1.1.0.0_141.0
guam-mra-1b N Standby 12.2.0.0.0_61.1.0
guam-mra-1a Y Active 12.1.1.0.0_14.1.0

122.0.0.0_61.1.0
121.1.0.0_14.1.0

12.2.0.0.0_61.1.0

CMP GUI: Continue the
backout of the MRA/MPE
clusters. Next operation
is initiate backout on the
spare server

NOTE: Up to 8 upgraded
clusters can be backed
out at the same time,
selecting one at a time.

1. Select the partially backed out cluster.

2. Navigate to Upgrade = Upgrade Manager.

3. Click Continue Rollback. When hovering over the button, it informs you

of a backout on the spare server.

Continue Rollback Resume Upgrade

Initiate backout guam-mra-1c (back) pate | Server Role | Prev Release

e JL EIL BIL [ [+ [+

View

Running Release

| = guam-mra-1 (3 Servers)

guam-mra-1c Y Spare 12.1.1.00_141.0
guam-mra-1b N Standby 12.2.0.0.0_61.1.0
guam-mra-1a Y Active 12.1.1.0.0_14.1.0

1220008110
1211.00_141.0

12.2.0.00_61.1.0

4. Click OK to confirm and continue with the operation.

Follow the progress in the Server Role column. The Server shows OOS in the

server role until the backout completes.

During the backout activities, the following alarms may

be generated and

considered normal reporting events—these are cleared after the cluster is

completely backed out.

Expected Critical Alarms

31283 Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed

Expected Major Alarm

78001 Rsync Failed

70004 QP Processes down for maintenance
31233 HA Path Down

31126 Audit blocked

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
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31106 Database merge to parent failure

31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled

31282 HA Management Fault

Backout of this server is complete when the Initiate backout completed
successfully at... message shows in the Upgrade Operation column. The spare
server goes back to running a pre-12.2 release.

Continue Rollback Resume Upgrade Wiew

=] Name Alarm Severity | Up to Date | Server Role | Prev Release Running Release
HC = _H |
| Bl [v] guam-mra-1 (3 Servers)
guam-mra-1c N Spare 12.2.0.0.0_81.1.0 12.1.1.0.0_14.1.0
guam-mra-1b N Standby 12.2.0.0.0_81.1.0 12.1.1.0.0_14.1.0
guam-mra-1a b Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0

CMP GUI: Continue the
backout of the MRA/MPE
clusters. Next operation
is failover to previous
release.

4. []

NOTE: Up to 8 upgraded
clusters can be backed
out at the same time,
selecting one at a time.

4.

Select the cluster to backout.
Current state of the cluster should be as follows:

- Spare server on previous release

- Standby server on previous release

- Active server on release 12.3

Navigate to Upgrade = Upgrade Manager.

Click Continue Rollback. When hovering over the button, it informs you
of a failover to the old version.

Continue Rollback Resume Upgrade Wiew

Failover to old version guam-mra-1 (back) | scrver Role | Prev Release Running Release

I | I £ | 2 | =]
| = guam-mra-1 (3 Servers)

guam-mra-1c N Spare 12.2.0.0.0_61.1.0 12.1.1.0.0_141.0

guam-mra-1b N Standby 122.0.0.0_61.1.0 121.1.0.0_14.1.0

guam-mra-1a Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0

Click OK to confirm and continue with the operation. It begins to fail
over.

Wait until the server fails over before selecting the next cluster. This takes a
minute or two.

Expected Critical Alarms

31283 HA Server Offline / Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed

Expected Major Alarm

70004 QP Processes down for maintenance
31233 HA Path Down
31126 Audit blocked
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Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
31282 HA Management Fault

State of the cluster looks like the following when the failover completes. The
active server is now running the previous release:

= Name Alarm Severity | Up to Date | Server Role | Prev Releasze Running Release

mra B2} ] | =] | ]

= |:| guam-mra-1 (3 Servers)

guam-mra-1c N Spare 12.2.0.0.0_61.1.0 12.1.1.0.0_14.1.0
guam-mra-1b N Active 12.2.0.0.0_81.1.0 12.1.1.0.0_14.1.0
guam-mra-1a A Standby 121.1.0.0_141.0 12.2.0.0.0_61.1.0

CMP GUI: Reapply the
configuration to the
MPE/MRA cluster that
completed the failover
successfully.

e  For MPE: Policy Server = Configuration = <MPE_cluster> = System
e For MRA: MRA->Configuration><MRA_cluster>—>System

The selected cluster has the status shown as Degraded running release 12.2
1. Click Reapply Configuration.

- The MPE opens a popup box showing the progress of the reapply
process.
- The MRA does not show anything.

2. Note the version is successfully changed to the previous release:

Diameter Routing

Maodify

Delete Reapply Configuration

The configuration was applied successfully.
Configuration

MName guam-mra-1
Status
Version 12.1.1.0.0_14.1.0

NOTE: The status showing Degraded is a normal reporting event because the
servers currently have different releases.

CMP GUI: Complete
backout of clusters

NOTE: The backout of a
single server takes
approximately 30

1. Navigate to Upgrade - Upgrade Manager.
2. Select the partially upgraded cluster to backout.

3. Click Continue Rollback. When hovering over the button, it informs you
of the current standby server to be backed out:
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minutes to C0mp|ete- Continue Rollback  Resume Upgrade View
NOTE: Up to8 upgraded Initiate backout guam-mra-1a (back) | serverRoke Prev Release Running Release

clusters can be backed
out at the same time,
selecting one at a time.

e L EICEIL [ [=]| ]

| = guam-mra-1 (3 Servers)

guam-mra-1c N Spare 12.2.0.0.0_61.1.0 12.1.1.0.0_14.1.0
guam-mra-1b N Active 12.2.0.0.0_61.1.0 12.1.1.0.0_14.1.0
guam-mra-1a Y Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0

4. Click OK to confirm and continue with the operation. The backout
process begins.

Follow the progress in the Upgrade Operation column.

Upgrade Operation

+") Initiate backout Completed Successfully at Nov 23, 2016 11:04:16.

+") Initiate backout Completed Successfully at Nov 23, 2016 10:26:06.

[Step 142] 2% Initiate kackout :: Backing out server upgrade ||

During the backout activities, the following alarms may be generated and
considered normal reporting events—these are cleared after the cluster is
completely backed out.

Expected Critical Alarms

31283 HA Server Offline / Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed

Expected Major Alarm

70004 QP Processes down for maintenance
31233 HA Path Down
31126 Audit blocked

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
31282 HA Management Fault

Backout of the server is complete when the Initiate backout completed
successfully message displays in the Upgrade Operation column. All of the
servers are on the pre-12.2 release and shows active/standby/spare

75 E85338-01




Software Upgrade Procedure

Step Procedure Result

=] Name Alarm Severity | Up to Date | Server Role | Prev Release Running Release Upgrade Operation

e L EI[L _EIL [= || [

| B guam-mra-1 (3 Servers)

guam-mra-1c N Spare 12.2.000.611.0 121.1.0.0_141.0 +Initiate backout Completed Successfully at
guam-mra-1b N Active 122.000_611.0 121.1.0.0_141.0 +)Initiate backout Completed Successfully at
guam-mra-1a N Standby 12.2.0.0.0_61.1.0 = 12.1.1.0.0_14.1.0 +! Initiate backout Completed Successfully at
7. ] Repeat this Procedure for remainder of MPE and MRA servers, if not fully
backed out yet.
8. |:| Final Syscheck Another Syscheck on all the backed out servers can be performed to ensure
all modules are still operationally OK before progressing to the next
Procedure.

---End of Procedure--- |

8.3.4 Backout Fully Upgraded Secondary CMP Cluster

NOTE: The Secondary CMP Site2 cluster must be backed out first using the Upgrade Manager—followed by
the Primary CMP Sitel cluster.

Step Procedure Result

1. |:| CMP GUI: Verify the | 1. Navigate to Upgrade = System Maintenance.
status of the CMP

2. (Optional) Click Filter and enter CMP in the Name field.
clusters

3. Confirm status of the cluster to be backed out
a. Primary CMP is on release 12.3
b. All other non-CMP clusters are on pre-12.3

c. Up to Date column shows Y for all servers

= Name Alarm Severity  Up to Date | Server Role Prev Release Running Release Upgrade Operation

cmp il ,—B i i i

=1 ] CMP Sited Cluster (2 Servers)

guam-cmp-1b Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0 +) Initiate upgrade Completed Successfully at

guam-cmp-1a Y Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0 +/) Initiate upgrade Completed Successfully at
= [0 CMP Site2 Cluster (2 Servers)

guam-cmp-2a Y Standby 124.1.0.0_14.1.0 12.2.0.0.0_61.1.0 +) Inttiate upgrade Completed Successfully at

guam-cmp2b Y Active 12.1.1.00_14.1.0 12.2.00.0_61.1.0 +") Initiate upgrade Completed Successfully at

2. |:| CMP GUI: backout 1. Navigate to Upgrade = Upgrade Manager.
secondary CMP

2. Select the checkbox for the secondary CMP cluster
cluster

3. Click Start Rollback. When hovering over the button, it informs you of a back

NOTE: The backout out of the standby server.

of a single server

takes approximately Start Rollback | Start Upgrade Ve
40 minutes to

Initiate backout guam-cmp-2a (back) iate | Server Role | Prev Release Running Release
complete.

(ZAT || BN £ | ) B = | I || N

= [ CMP Sitet Cluster (2 Servers)

guam-cmp-1b Y Active 121.1.0.0_14.1.0 122.0.0.0_61.1.0

guam-cmp-1a Y Standby 121.1.0.0_14.1.0 12.2.0.0.0_81.1.0

=2 CMP Site2 Cluster (2 Servers)

guam-cmp-2a il Standby 121.1.0.0_141.0 122.0.0.0_61.1.0

guam-cmpZb Y Active 121.1.0.0_14.1.0 122.0.0.0_61.1.0

4. Click OK to confirm and continue with the operation. The backout begins.
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The server goes into an OOS server Role
Follow the progress in the Upgrade Operation column.
| = [4] CMP Site2 Cluster (2 Servers)
guam-cmp-2a X) Critical N 00s 1220008110 1220008110 Initiate backout :- Backing out server.
guam-cmp2b X) Critical Y Active 12.1.1.0.0_14.1.0 122.0.00_61.1.0 ) Initiate upgrade Completed Successfully at Nov 21, 201...
During the backout activities, the following alarms may be generated and
considered normal reporting events—these are cleared after the cluster is
completely backed out.
Expected Critical Alarms
31283 HA Server Offline / Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed
70025 The MySQL slave has a different schema version than the master.
Expected Major Alarm
70004 QP Processes down for maintenance
31233 HA Path Down
31126 Audit blocked
Expected Minor Alarms
70503 Server Forced Standby
70507 Upgrade In Progress
70500 System Mixed Version
70501 Cluster Mixed Version
78001 Rsync Failed
70502 Cluster Replication Inhibited
31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
31282 HA Management Fault
Backout of the server is complete when the Initiate backout completed
successfully at... message shows in the Upgrade Operation column. The server
returns to standby state and shows the previous release.
= Name Alarm Severity | Up to Date | Server Role | Prev Release Running Release
N = | = | I £ | [=] | ]
B O cmp sitet Cluster (2 Servers)
guam-cmp-1b &, Minor Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0
guam-cmp-1a h Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0
= CMP SiteZ Cluster (2 Servers)
guam-cmp-2a X/ Critical N Standby 12.2.0.0.0_61.1.0 12.1.1.0.0_14.1.0
guam-cmp2b Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0
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3. []| CMP GUI: Continue 1. Navigate to Upgrade - Upgrade Manager.
the backout. Next

S 2. Select the checkbox for the Secondary CMP cluster
operation is failover

3. Click Continue Rollback. When hovering over the button, it informs you of a
fail over to the previous version.

Continue Rollback Resume Upgrade Vie
Failover to old version CMP Site2 Cluster (back) 30 prey Release Running Release
S 3 I | | i |1 [=]
E [ cMP site1 Cluster (2 Servers)
guam-cmp-1b &, Minor A Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0
guam-cmp-1a h Standby 12.1.1.0.0_14.1.0 12.2.00.0_8611.0

= CMP Site2 Cluster (2 Servers)

guam-cmp-2a  \#) Critical N Standby 12.2.0.0.0_61.1.0 12.1.1.0.0_14.1.0

guam-cmp2b Y Active 121.1.0.0_141.0 12.2.0.0.0_81.1.0

4. Click OK to confirm and continue with the operation. The failover process
begins.

Wait until the previous release becomes active before continuing

Expected Critical Alarm

70025 QP Slave database is a different version than the master

Expected Minor Alarms

70503 Server Forced Standby
70501 Cluster Mixed Version
78001 Rsync Failed

70500 System Mixed Version
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Result

4. []

CMP GUI: Continue
the backout. Next
operation is initiate
backout

1. Navigate to Upgrade - Upgrade Manager.
2. Select the checkbox for the Secondary CMP cluster

3. Click Continue Rollback. When hovering over the button, it informs you of a
back out of the new standby server.

Continue Rollback Resume Upgrade Vie!

Initiate backout guam-cmp2b (back) pate  ServerRole | Prev Release Running Release

(ZAP R | £ | B | =] =]

B O cMP sited Cluster (2 Servers)

guam-cmp-1b /& Minor Y Active 124.1.0.0_14.1.0 12.2.0.0.0_61.1.0

guam-cmp-1a i Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0

= CMP Site2 Cluster (2 Servers)

guam-cmp-2a  '#) Critical N Active 12.2.0.0.0_61.1.0 12.1.1.0.0_14.1.0

guam-cmp2b Y Standby 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0

4. Click OK to confirm and continue with the operation. The failover process
begins.

Follow the progress of the status in the Upgrade Operation column.

Expected Critical alarm

70025 QP Slave database is a different version than the master

Expected Minor Alarms

70500 System Mixed Version

The procedure is completed when both servers in the Secondary CMP are in the
previous release.

=] Name Alarm Severity | Up to Date | Server Role | Prev Release Running Release Upgrade Operation

(S | N N £ || I B [

£ [ cmp sited Cluster (2 Servers)

guam-cmp-1b Y Active 12.1.1.0.0_14.1.0 12.2.0.0.0_61.1.0 ) Initiate upgrade Completed Successfully at

guam-cmp-1a Y Standby 12.1.1.0.0_14.1.0 122.0.0.0_61.1.0 ) Initiate upgrade Completed Successfully at

= CMP Site? Cluster (2 Servers)

guam-cmp-2a X/ Critical N Active 12.2.0.0.0_611.0 12.1.1.0.0_14.1.0 +) Initiate backout Completed Successfully at

guam-cmp2h ) Critical N Standby 12:2.0.0.0_61.1.0 121.1.00_14.1.0 ) Initiate backout Completed Successfully at

---End of Procedure---
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8.3.5 Backout Fully Upgraded Primary CMP Cluster

NOTE: The Secondary CMP Site2 cluster to be backed out first using the Upgrade Manager—followed by the Primary
CMP Sitel cluster. For rollback to 12.2.x, use both the Upgrade Manager and System Maintenance. For rollback to
release 12.2.x, only use the Upgrade Manager.

Step Procedure Result

1. |:| CMP GUI: Verify the | 1. Navigate to Upgrade Manager = System Maintenance.
status of the CMP

2. Confirm status of the cluster to be backed out:
clusters

- Primary Active CMP is on release 12.3
- Secondary CMP cluster is on pre-12.2 release 10.5, 11.5, 12.0, or 12.1.1

- Up to Date column shows Y for all servers in the primary CMP cluster

= Name Alarm Severity | Up to Date | Server Role Running Release Upgrade Operation

=2 O cmp sitet Cluster (2 Servers)
guam-cmp-1b Y Active 122.0.0.0_61.1.0 +) Initiate upgrade Completed Successfully af]
guam-cmp-1a Y Standby 12.2.0.0.0_81.1.0 +) Initiate upgrade Completed Successfully af]

E O cMmP site2 Cluster (2 Servers)

guam-cmp-2a @ &) Critical M Active 12.1.1.0.0_14.1.0 +") Initiate backout Completed Successfully at
guam-cmp2b ) Critical M Standby 12.1.1.0.0_14.1.0 +*) Initiate backout Completed Successfully at
2. []| CMP GUI: backout 3. Navigate to Upgrade = Upgrade Manager.
standby Primar .
¥ y 4. Select the checkbox for the Primary CMP cluster
CMP cluster
5. (Optional) Click Filter and enter CMP in the Name field.
NOTE: Backout of (Op ) € _
one server takes 6. Click Start Rollback. When hovering over the button, it informs you of the
approximately 40 server to get backed out.
minutes to
Complete Start Rollback Start Upgrade

Initiate backout guam-cmp-1a (back) yate Server Role Running Release

2 | 2 | NN 2 | NN £ || IS

| = CMP Site1 Cluster (2 Servers)

guam-cmp-1b Y Active 12.2.0.0.0_61.1.0

guam-cmp-1a Y Standby 122.0.0.0_61.1.0

7. Click OK to confirm and continue with the operation. The backout process
begins. The server goes into an O0S Server Role

Follow the progress of the status in the Upgrade Operation column.

During the backout activities, the following alarms may be generated and
considered normal reporting events—these are cleared after the cluster is
completely backed out.

Expected Critical Alarms

31283 HA Server Offline / Lost Communication with server
31227 HA availability status failed

70001 QP_procmgr failed

31236 HA Link Down

Expected Major Alarm

70004 QP Processes down for maintenance
31233 HA Path Down
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Expected Minor Alarms

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

Backout of the server is complete when the Initiate backout completed
successfully message shows in the Upgrade Operation column. The server
returns to the Standby state and shows the previous release.

= Mame Alarm Severity | Up to Date | Server Role | Running Release | Upgrade Operation
[ [ [

| =] CMP Site1 Cluster (2 Servers)

guam-cmp-1b % Minor h i Active 12.2.0.0.0_61.1.0 | v Initiate upgrade Completed Successfully at|

guam-cmp-1a = ' X) Critical N Standby 12.1.1.0.0_14.1.0 : v Initiate backout Completed Successfully at

CMP GUI: Continue
the backout. Next
operation is failover

1. Navigate to Upgrade = Upgrade Manager.
2. Select the checkbox for the Primary CMP cluster

3. Click Continue Rollback. When hovering over the button, it informs you of a
fail over.

Continue Rollback Rezume Upgrade View Upgrade Log L Fitter Columnz +

Failover to old version CMP Site1 Cluster (back) roe | Running Release

a3 | N = | N 3 § N £ || I

| = CMP Sited Cluster (2 Servers)

Upgrade Operation

guam-cmp-1b £ Minor b i Active 12.2.0.0.0_81.1.0 '+ Initiate upgrade Completed Successfully at

guam-cmp-1a X) Critical N Standby 12.1.1.0.0_14.1.0 ' '+ Initiate backout Completed Successfully at

4. Click OK to confirm and continue with the operation. The failover process
begins.

Failover takes a couple minutes.
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4. |:| CMP GUI: Log back After failover, you are required to log back in to the CMP GUI using the Primary
in to the Primary CMP VIP.
CMP VIP

ORACLE’

5. |:| CMP GUI: Verify Navigate to Help=>About. Verify the release number is not 12.2 anymore.

release
e Ifthe rollback is for release 12.2.x, continue with step 6.

e Ifthe rollback is for release 12.2.x, continue with step 8
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6. [ ]| CMP GUI (release
12.2.x): Continue
the backout of the
Primary CMP cluster

NOTE: Backout of
one server takes
approximately 30
minutes to
complete.

1. Navigate to Upgrade = System Maintenance.

2. Select the remaining server in the Primary CMP cluster. The server is 12.3

and shows Forced Standby in the Server State column.

Name Appl Type Site P Server State 150 Relence | Reloase T | Replication
1 ¥ CMP Site1 Cluster CMP Sitel Cluster

! CMP240-132 CMP Sited Cluster | {10.148.240.132 Force Standby ¥icmp-12.1.2.0.0_22.1.0-x86_64.is0 10.5.6_1.1.0 12'12'_21'%0*2 on

v CMP240-133 CMP Sitel Cluster  Unspecified 10.148.240.133 Active #lemp-12.1.2.0.0_22.1.0-x86_64.is0 2 1221%0—2 10.5.6_1.1.0 on

3. Select Operations—>Backout

{2015 18:18:25 )

) Prev
Release

4. Click OK to continue

Follow the progress in the Upgrade Operation column. Wait until the server to
backout comes to backout complete.

Upgrade Operation

Infiate upgrade - Upgrading server (Elapsed Time: 0:0

) Initiate upgrade Completed Successfull at Sep 18, 2015 14:10:18.

During the Backout activities, the following alarms may be generated and
considered normal reporting events. These are cleared after the cluster is
completely backed out.

Expected Critical Alarms

31283 HA Server Offline / Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby

70507 Upgrade In Progress

70500 System Mixed Version

70501 Cluster Mixed Version

78001 Rsync Failed

70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure
31102 Database replication from master failure
31113 DB replication manually disabled
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7. ]

CMP GUI: Remove
Forced Standby

1. Navigate to Upgrade = System Maintenance.

2. Select the remaining server in the Primary CMP cluster. The server is on
12.2.x and shows Forced Standby in the Server State column.

NOTE: A refresh of the current screen may be necessary at approximately
the 40 minute mark.

3. Select Operations=>Cancel Forced Standby

Pl Upgrade Status|

The backout procedure is now completed for release 12.2.x.

CMP GUI (release
12.2.x): Continue
the backout of the
Primary CMP cluster

NOTE: The backout
of one server takes
approximately 40
minutes to
complete.

1. Navigate to Upgrade - Upgrade Manager.
2. Select the checkbox for the Primary CMP cluster

3. Click Continue Rollback. When hovering over the button, it informs you of
the server to back out. In this case, it is the current standby server still
running 12.2.

Continue Rollback Resume Upgrade View Upgrade Log

Initiate backout guam-cmp-1b (back) jate | server Role | Prev Release Running Release

= CMP Site1 Cluster (2 Servers)

guam-cmp-1b ' %) Critical A Standby 12.1.1.00_141.0 : 122.000_81.1.0

guam-cmp-1a £, Minor N Active 12.2.0.0.0 61.1.0 : 121.1.0.0_14.1.0

4. Click OK to confirm and continue with the operation. The backout process
begins. Server goes into an OOS server Role

Follow the progress in the Upgrade Operation column.

During the backout activities, the following alarms may be generated and are
considered normal reporting events. These are cleared after the cluster is
completely backed out.

Expected Critical Alarms

31283 HA Server Offline / Lost Communication with server
31227 HA availability status failed
70001 QP_procmgr failed

Expected Major Alarm

70004 QP Processes down for maintenance

Expected Minor Alarms

70503 Server Forced Standby
70507 Upgrade In Progress
70500 System Mixed Version
70501 Cluster Mixed Version
78001 Rsync Failed
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70502 Cluster Replication Inhibited

31114 DB replication over SOAP has failed
31106 Database merge to parent failure
31107 Database merge from child failure
31101 Database replication to slave failure

31102 Database replication from master failure
31113 DB replication manually disabled

Backout of the server is complete when the following message (initiate backout
completed successfully) shows in the Upgrade Operation column. The server
returns to the Standby state and shows the previous release.

StartRollback  Resume Upgrade

8 |Name Alam Sev_ |Upto . | ServerRole Prev Release

Running Release

View UpgradeLog  ©Filter  Colum

Upgrade Operation

£/ CMP Site1 Cluster (2 Servers)

CMP235 N Active 1212002210
CMP236 N Standby 1212002210
/0] CMP Site2 Cluster (2 Servers)

CHP2-38 N Standby 1212002210

CMP2-39 N Active 1212002210

121.1.00_14.1.0
121.1.00_14.1.0

121.1.00_14.1.0
121.1.00_14.1.0

) Initate backout Completed Successiully at Sep 1, 2016 16:47:26.
) Initate backout Completed Successully at Sep 1, 2016 17:08:13,

) Initate backout Completed Successuly at Sep 1, 2016 16:34:36.

) Initate backout Completed Successully at Sep 1, 2016 16:21:26.

Final syscheck

A syscheck on all the backed out servers, can be performed to ensure all
modules are still operationally OK before progressing to the next procedure.

---End of Procedure---
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APPENDIX A. TVOE AND PM&C SERVER UPGRADE
Use this procedure to add the TVOE software image to the TVOE host.

Check off (V) each step as it is completed. Boxes have been provided for this purpose under each step

number.

If this procedure fails, contact Oracle Support.

Adding TVOE software image to TVOE host

Step Procedure

Description

1. [_] TVOE Host: Verify there is
enough space on the
server for TVOE software
image

Log in to the TVOE host and run the following to verify there is sufficient space:

$ df -h /var/TKLC/upgrade/

The system returns output similar to the following to indicate the disk usage of
where the TVOE software image should reside.

Filesystem Size Used Avail Use% Mounted
on

/dev/mapper/vgroot-plat var tklc 4.0G 848M 3.0G 23% /var/TKLC

If the Avail column is smaller than the size of the TVOE software image, contact
Oracle Support for information about how to proceed.

2. []| Add TVOE software image
to TVOE host

Place a copy of the TVOE software image into the /var/TKLC/upgrade/ directory on
the TVOE host by utilizing scp or USB media.
e  SCP from customer PC using Linux

From the command line of a Linux machine, use the following command to
copy the backup ISO image to the TVOE host:

$ scp <path to image> <user>@<TVOE ip>:/var/TKLC/upgrade/
e Where <path_to_image> is the path to the TVOE ISO image local to the

Customer PC and <TVOE_ip> is the TVOE IP address. <user> should be admusr
for TVOE releases 2.5 or newer.

e  SCP from customer PC using Windows

Use WinSCP to copy the TVOE ISO image to the TVOE host.
e USB Media

d. Attach the USB media to the TVOE host.

e. Login on the TVOE host and run the following to list ISOs on the USB
media:

$ sudo 1ls /media/*/*.iso
/media/usb/TVOE-3.0.3.x.x 86.4.0-x86 64.iso0

f.  Replacing <PATH_TO_TVOE_ISO> with the output of the command above,
copy the ISO to the /var/TKLC/upgrade directory:

$ sudo cp <PATH TO TVOE ISO> /var/TKLC/upgrade/
g. Unmount the USB media:

$ sudo umount /media/usb

---End of Procedure---
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8.4TVOE Upgrade
This procedure provides basic steps to upgrade the PM&C Server to 6.0.3 and the TVOE host to 3.0.3

NOTE: The TVOE upgrade procedure can executed either during the same maintenance window as PM&C
upgrade or in a separate maintenance window.

NOTE: If PM&C TVOE host cannot be upgraded at this time then PM&C upgrade must not be attempted.

e TVOE Pre-Upgrade Validation

e Pre-Upgrade Backup

e Add TVOE Software Image to TVOE HOST

Add PM&C Upgrade Software to PM&C Server
Stand Alone TVOE Host Upgrade

TVOE Post-Upgrade Validation

PM&C upgrade

e Stand Alone TVOE Upgrade Accept

e PM&C Upgrade Accept

NOTE: It is recommended NOT to accept TVOE upgrade until after PM&C upgrade has been accepted for
the following reasons:

e If you're upgrading from PM&C 5.5, this release cannot be deployed on an upgraded TVOE 3.0.3
system.

e Ifanissue occurs during PM&C upgrade, it may require disaster recovery for which TVOE upgrade
has to be rejected to allow PM&C 5.5 to be re-deployed.

e Areject cannot be performed after an upgrade has been accepted.

Check off (V) each step as it is completed. Boxes have been provided for this purpose under each step
number.

Step Procedure Details

1. O NOTE: Upgrade of TVOE host shuts down all guest OS (including PM&C)
during the upgrade. Still, prior to upgrading the TVOE host, ensure the PM&C
server is gracefully shut down.
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Step Procedure Details

2. 0O | Check any in-progress 1. Onasupported web browser, log in to PM&C GUI as pmacadmin

tasks on PM&C 2. Navigate to PM&C GUI background tasks page:

Main Menu => Task Monitoring

- [ Logout

3. Verify all tasks are complete indicated by green 100% progress

NOTE: If any task shows in-progress (blue or red) then wait for the task to
complete prior to continuing the next step.

Background Task Monitoring
D Task Target Status Running Time  StartTime  Progress
[ 131 Backup PM&C PM&C Backup successful 0:00:01 i 100%
o 2015.03.05
) 130 Backup PM&C PM&C Backup successful 0:00:01 Sonn 100%
2015-03-04
[) 129 Backup PM&C PM&C Backup successful 0:00:02 Fd 100%
) 128 Backup PM&C PMAC Backup successful 0:00:02 52105’00032” 100%
127  Upgrade Enc:10001 Bay:3F success 0:28:30 RIS TINE 100%
16:03:01
126 Upgrade £nc:20001 Bay:10F success 0:39:51 20190502 100%
16:02:30
. ¥ . 2015.03.02
[) 125 Upgrade Enc:10001 Bay:9F Success 0:35:00 s 100%
Done: TPD.nstall-5.1.1_73.5.3- 2015.03.02
) 124 instal 08 Enc:10001 Bay:3F G 0:16:31 Ers 100%
Done: TPD.nStall-5.1.1_73.5.3- 2015.03.02
) 123 Instal 0§ Enc:20001 Bay-10F e 0:19:43 s 100%
Done: TPD.nstall-5.1.1_73.5.3- 2015.03.02
j 122 Install OS Enc:10001 Bay:9F Cent0S5.8-x86_64 0:19:33 15:25:24 100%
) 121 upgrade Enc:20001 Bay:11E Success 0:28:13 20150502 100%
14:23:28
. X o 2015.03.02
) 120 Upgrade Enc:10001 Bay:-11E Success 0:20:07 e 100%
2015.03.02
) 19 Upgrade Enc:20001 Bay:3F Success 0:33:25 Eyos 100%
Delete Completed || Delete Failed || Delete Selected
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Step Procedure Details

3. O | Shutdown PM&C NOTE: Assuming all tasks are completed (previous step) it is safe to shut
down PM&C

1. Logon tothe TVOE host as admusr

2. Obtain the name of the PM&C guest by executing the following
command:

$ sudo virsh list --all

Id Name State

1 <pmac name> running

3. Stop the PM&C process by using the following command:

$ sudo virsh shutdown <pmac name>

NOTE: It is imperative to log into the TVOE host instead of using ssh to the
PM&C guest. The upgrade might fail otherwise.

4. O | Verify PM&C guest is 1. Loginto the TVOE host as admusr.

shut down 2. Verify that the PM&C is shut down with the following command:

[admusr@tvoe ~]# sudo virsh list --all

NOTE: This should show PM&C guest state as shut off.

89 E85338-01



Software Upgrade Procedure

Step Procedure Details

5. [ | Validate media 1. Loginto the TVOE host as admusr

2.  Run the platcfg utility
$ sudo su - platcfg

3. Navigate to Maintenance = Upgrade - Validate Media.
4. Select the new TVOE ISO

lggogggggggggagggagaqu Choose Upgrade Media Menu tgggoggagggggaaaaaadoaky

unfefeele(s(efefe(s(s(e(e{e(s (s(e{e s (s(ote (s(e (e (efe e (e (ote (o (s (e{efe (s (oo (s o (s (e(ofe (s(s(e (e (s (s (e (e{e v s (ole (s (o (s (s (e s (s (a]e (v o]

5. Press Enter to validate the ISO file
The TVOE ISO image is validated with an expected result of:
The media validation is complete, the result is: PASS

If the image validation fails, this procedure should be stopped. The ISO
image should be copied again to the TVOE host and this procedure should be
re-started from the beginning.

6. [ | Start TVOE upgrade 1. Press Enter to return to platcfg and then press Exit to go back to the

NOTE: The upgrade Upgrade menu. Do not quit platcfg.

process takes 2. Navigate to Maintenance = Upgrade > Initiate Upgrade.
approximately 15 )
p.p y 3. Select the new TVOE ISO filename
minutes
loggggggggagggggagggggu Choose Upgrade Mediza Menu tggggagoggggaaaaaagggl
=]
x]
]
X =]

unfefeele(s(efefe(s(s(e(e{e(s (s(e{e s (s(ote (s(e (e (efe e (s (ote (o (s (e{efe (s (oo (s o (s (o(ofe (s(s(e (e (s (s (e (e{e v (s (ole (s (o (s (s (e s (s (a]e (v o]

4. Press Enter to initiate the upgrade

NOTE: TVOE host is rebooted at the end of the upgrade process (around 15
minutes) and returns to the login prompt. At this point the upgrade is
complete.
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Step Procedure Details

7. O | Verify the Upgrade 1. Login to TVOE as admusr
status

2. Verify the upgraded TVOE revision by executing the following command:
SappRev

You get an output similar to this:

3. Run the following command:

$sudo verifyUpgrade

No output is expected from this command. Any output displays
potential issues.

4. Perform a syscheck:

$sudo syscheck
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Step

Procedure

Details

8. O

NOTE: It is recommended not to accept TVOE upgrade until after PM&C
upgrade has been accepted for the following reasons:

e Some older PM&C releases cannot be deployed on upgraded TVOE 3.0.3
system.

e Ifissues occurs during PM&C upgrade it may require disaster recovery
for which TVOE upgrade has to be rejected to allow older PM&C to be
re-deployed.

e Areject cannot be performed once an upgrade has been accepted.

---End of Procedure---

8.5PM&C Upgrade

This procedure provides instructions to perform software upgrade of the PM&C.

Check off (V) each step as it is completed. Boxes have been provided for this purpose under each step

number.
Step Procedure Details
1. O | Start the PM&C guest 1. If not already logged in to the TVOE host as admusr, do so.

2. Start the PM&C guest if not already started:

3. Query the list of guests to check whether the PM&C guest is in state
running.

$ sudo virsh list --all
Id Name State

1 <pmac name> running

- Ifitis running, skip to the next step.

- Ifitis not running, issue the following command.

$ sudo virsh start <pmac name>

Domain <pmac name> started

2. 0O | Close any active If any open browsers are connected to PM&C, close them before proceeding
browser sessions to
PM&C
3. O | Logintothe TVOE host | 1. From the TVOE host CLI, issue the following command to log on to the
as root PM&C guest as admusr:
$sudo virsh console <pmac name>
NOTE: It might be needed to press Enter twice.

2. Verify the correct ISO file is located in the /var/TKLC/upgrade directory
of the PM&C guest. If not, copy the PM&C ISO to /var/TKLC/upgrade
on the PM&C guest.

3. Verify by issuing the following command:

# 1s -1th /var/TKLC/upgrade
4. 0O | Execute upgrade from From PM&C guest as admusr (accessed via the TVOE virsh console in the

PM&C Server

previous step), run the platcfg utility:
# sudo su - platcfg
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Step

Procedure

Details

5. 0O

In the platcfg utility
select Initiate Upgrade
to start the upgrade
process

In platcfg, navigate to Maintenance->Upgrade—>Initiate Upgrade.

Select Initiate Upgrade to start the upgrade process

Wait for the Choose Upgrade Media Menu screen to display before
proceeding to the next step

Select the new PM&C 6.0.3 target ISO filename and press Enter to start
the upgrade process

The upgrade begins and after approximately 20 minutes, the connection
is lost as it reboots.

Do not take any action on the PM&C until the server reboots. The
reboot takes approximately 5 minutes.

Log back into PM&C and you see something similar to the following:
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Step

Procedure

Details

6. 0O

PM&C GUI: Verify the 1. Open a browser and type in the IP address of the PM&C server

upgrade after

approximately 30

minutes

2. Login as pmacadmin.

3. Verify the release at the top of the page.

ORACLE" Platform Management & Configuration
6.0.3.0.2-60.28.0

4. Navigate to the task manager and verify all tasks are complete. DO NOT
proceed with the next step until all tasks are completed.

Tasks still in progress:

Background Task Monitoring & Help
Wed Dec 07 18:07:22 2016 UTC
ID Task Target Status State Running Time
] 511 Add Enclosure Enc:702 OpenHpi Deamon Started IN_PROGRESS 0:01:02
] 510 Add Enclosure Enc:701 OpenHpi Deamon Started IN_PROGRESS 0:00:37
[ 509 Add Enclosure Enc702 TR TSI =S COMPLETE 0:06:01
monitoring
|} sog Add Enclosure Enc:701 frerebeilisl S COMPLETE 0:08:06
- monitoring
|} s07 Add Enclosure Enc:702 frete e ilsl -G COMPLETE 0:06:01
- monitoring
|) 506 Add Enclosure Enc:701 frenEbeilsl - i COMPLETE 0:06:30
- maonitoring
:I 505 Backup PM&C PM&C Backup successful COMPLETE 0:00:04
:I 504 Backup PM&C PM&C Backup successful COMPLETE 0:00:04

Pl mn 3

---End of Procedure---

8.6 Verify PM&C Upgrade

This procedure provides instructions to verify success of the PM&C upgrade and perform other required
post upgrade steps

Check off (V) each step as it is completed. Boxes have been provided for this purpose under each step

number.
Step Procedure Details
1. 0O | Access PM&C 1. Logon to TVOE host SSH as admusr.

guest console

2. Verify that the PM&C console is running by issuing the following command

$ sudo virsh list

brbgpmac

3. Logon to PM&C guest console by issuing the following command from the TVOE console:
$ sudo virsh console <pmac name>

Remember to press Enter twice.

NOTE: If you connected from the TVOE console, the guest session to PM&C is broken with
CTRL+]
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Step Procedure Details

2. 0O | Verify the 1. Logged in to the PM&C console, execute the following command
date/timestamp

$ 1s -1 /var/TKLC/log/upgrade/upgrade.log

2. Verify that the date and timestamps up the upgrade align with the actual time of the
upgrade.

3. O | Verify that the Run the following command and verify the release
release version

S appRev
has been
updated
4. 0O | Verify Run the following commands on PM&C
successﬂﬂ $ grep COMPLETE /var/TKLC/log/upgrade/upgrade.log
completion
through the
upgrade log
$sudo verifyUpgrade
NOTE: This command could take over a minute to complete. No output is expected, only the
prompt should return. If there are messages, contact Oracle support.
5. [ | Runsyscheck Run syscheck and verify everything is Ok

$ sudo syscheck
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Step Procedure Details
6. O | PM&CSSHCLI: | 1. Verify that the ssh service exists with admusr credentials by executing the following
Recreate the command:
ssh_service

with admusr
credentials on
PM&C guest
console if it
doesn’t exist

$ sudo netConfig --repo showService name=ssh service

- If the results are similar to the above, that is, the Options field include usr: admusr
and an encrypted password, skip to the next step.

- Ifthe Options field does not include the usr: admusr or if the service does not exist,
continue with this step:

Delete the ssh_service if it exists

$ sudo netConfig --repo deleteService name=ssh service
Answer YES to the message if prompted.

Recreate ssh_service with admusr user.

$ sudo netConfig --repo addService name=ssh service
Service type? (tftp, ssh, conserver, oa) ssh
Service host? <pmé&c ip address>

Enter an option name (q to cancel): user

Enter a value for user: admusr

Enter an option name (g to cancel): password

Enter a value for password: Dukx****xx

Verify Password: Duk******

Enter an option name(q to cancel): g

Example output

4.

Ensure the information entered is correct by executing the following command and
compare the output with the configuration in the last step -

$ sudo netConfig --repo showService name=ssh service

Example output
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Step Procedure Details

7. O If ALL health checks passed, accept PM&C server and TVOE upgrades.

If health checks do not pass or a backout is needed, skip to Appendix B to reject/backout the
upgrade in entirety. This includes both the PM&C server and the TVOE host.

8. O | Acceptthe 1. Close any open PM&C GUI browsers
upgrade for . .
PME&C NOTE: After accepting the upgrade, you are not able to roll back to the previous release.

NOTE: Accept - Logon to PM&C guest console

takes - Run the platcfg utility.
approximately 5 $ sudo su - platcfg
minutes 2. Navigate to Maintenance=>Upgrade.

lggggggqu Upgrade Menu togggggaaalk

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copyv USBE Upgrade Image
Non Tekelec RPM Management
I ept Up de

Reject Upgrade

Exit

[MogdggdggagaIgaIgaIdaIgaaaaaaa
3. Select Accept Upgrade and press Enter.

laggggggggaggggggggu Main Menu tggggggogagggagaagagl

Do yvou really want to accept the upgrade?

1 aaaao kil gaaok]
x No =
moararara i mooaad

roggggggggggaaadaadaaddaaaaaaaaaaadddddaggggggggaa]

4. Click Yes to start accept upgrade process.

If a message displays prompting you to hit any key to continue, DO NOT hit any key, the server
reboots on its own.

The connection is lost while the PM&C reboots (approximately 5 minutes).
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Step

Procedure

Details

9. O

Health Checks

1. Run the following command:

Ssudo syscheck
2. Open a browser and launch the PM&C GUI.

3. Verify the release at the top of the page.

ORrRACLE Platform Management & Configuration
6.0.3.02-60.28.0

Navigate to Task Manager and monitor as tasks complete. DO NOT continue to the next step
until all tasks are complete. It may take more than 5 minutes to complete.

Background Task Monitoring & Help

Wed Dec 07 18:07:22 2016 UTC
Filter =

D Task Target Status State Running Time

j 511 Add Enclosure Enc:702 OpenHpi Deamon Started IN_PROGRESS 0:01:02 Al

j 510 Add Enclosure Enc:701 OpenHpi Deamon Started IN_PROGRESS 0:00:37

[ 509 Add Enclosure Enc:702 I SETOEHTEGEITITTT COMPLETE 0:06:01
monitoring

] 508 Add Enclosure Enc:701 I SETOEITEGEITITT COMPLETE 0:08:06
monitoring

[7) 507 Add Enclosure Enc:702 EIE TSI TITET -SRI COMPLETE 0:06:01
monitoring

] 506 Add Enclosure Enc:701 SR TSR TR - S0 COMPLETE 0:06:30
monitoring

j 505 Backup PM&C PM&.C Backup successful COMPLETE 0:00:04

j 504 Backup PM&C PM&.C Backup successful COMPLETE 0:00:04

o 1 3
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Step Procedure Details
10. O | Accept the NOTE: It is recommended not to accept the TVOE upgrade until after the PM&C upgrade has
upgrade for been accepted for the following reasons:
TVOE
- Some older PM&C releases cannot be deployed on upgraded TVOE 3.0.3 system.
- Ifissues occurs during PM&C upgrade it may require disaster recovery for which TVOE
upgrade has to be rejected to allow older PM&C to be re-deployed.
- Areject cannot be performed once an upgrade has been accepted.
NOTE: After the upgrade is accepted, you are not able to roll back to the previous release.
1. Login as admusr to TVOE host CLI and run the platcfg utility:
$ sudo su - platcfg
2. Navigate to Maintenance->Upgrade.
lggggggqu Upgrade Menu tgggggagak
Validate Media
Early Upgrade Checks
Initiate Upgrade
Copy USE Upgrade Image
Non Tekelec RFM Management
ke pgrade
Reject Upgrade
Exit
Maqgqgqadagadadaddadadadadaaaadad
3. Select Accept Upgrade and press the Enter.
lagggggggggaggggggqu Main Menu tgggguagagddddqdgdddl
Do yvou really want to accept the upgrade?
M1 qoagk
X Ho x
magggg] mgggq]
mggggg999gyggggggadadadgdadadaddggadadadaaadaaaadgdd]
4. Click Yes to start accept upgrade process.
NOTE: A screen session is launched when accepting the upgrade, press q to close the window
and return to platcfg utility.
lgggggaaagaaaaadaaddagu Message tgggagadaaddadadaaagaaky
re =]
|x The accept has completed. =
re =]
re =]
re =]
re =]
re =]
re =]
re =]
re =]
re =]
I Press any key to continue... =]
re =]
mqqqqqClC!C!CIqqqCIClClC!CIC!C!C!ClqClqClqC!qqqqqqqqqqqqqqqqqqqqqqqch
5. Select and press Enter on the Exit menu or press F12 until exiting platcfg.
The upgrade process is now complete.
---End of Procedure---
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APPENDIX B. TVOE AND PM&C SERVER BACKOUT

This procedure provides instructions to backout/reject the PM&C server upgrade.

NOTE: A reject cannot be performed after an upgrade has been accepted.

Check off (\/) each step as it is completed. Boxes have been provided for this purpose under each step

number.

Step Procedure

Details

1. O | Close any active
browser sessions
of PM&C

Close any open browsers connected to PM&C before proceeding.

2. O | If necessary,
access PM&C
guest console

1. Logon to TVOE host as admusr

2. Verify PM&C console is running by issuing the following command

Ssudo virsh list

3. Logonto PM&C guest console by issuing the following command

$sudo virsh console <pmacname>

4. Logonto PM&C as admusr if needed — may not require a login.
Last login: Wed Jun 6 08:39:14 on ttySO
| |
| This system has been upgraded but the upgrade has not yet |

| been accepted or rejected. Please accept or reject the |
| upgrade soon.
| |

[admusr@pmac ~]$

NOTE: To break the guest session to go back to TVOE host, press CTRL+]
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Step Procedure Details
3. 0O | Runthe platcfg 1. Atthe prompt, run:

utility on the Seuee Su — placei

PM&C Server

2. Navigate to Maintenance—>Upgrade
4' Upgrade Menu Ii

Validate Media

Early Upgrade Checks
Initiate Upgrade

Non Tekelec RPM Management
Aocept Upgrade

3. Select Reject Upgrade and press Enter to start the reject process.

The following window opens, enter yes to begin the backout.

I Main Menu I

Do you really want to reject the upgrade?

NOTE: 5 minutes into the backout, a reboot completes the backout, the system reboots
automatically.

4. 0O | Backout requires
reboot

The following image is only for illustrative purposes

NOTE: DO NOT press any key when the window prompts, the system reboots on its own.

I Message I

The reject has completed.
The system will now be rebooted.

Press any key to continue...

NOTE: From this point on, it takes approximately 20 minutes to complete the backout

5. O | Wait for PM&C
login prompt

After the successful completion of backout, the user is returned to a login prompt.

Login as admusr.
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Step Procedure Details
6. O | Verify backout Execute the following command to verify source PM&C release:
completed

[admusr@pmac ~]# appRev

If the correct Product Release is not displayed, contact Oracle Customer Service and do
not proceed until instructed by an Oracle Customer Care representative.

7. O | TVOE iLo SSH As Administrator on the TVOE iLO — log in through the iLO and execute the following
command to check the logical drives that are used for the backout.

Login as admusr to the TVOE console

$sudo /sbin/lvs -o lv_name, snap percent Qupgrade

Typical output:

LV snap %
plat root snap 27 .52
plat usr snap 7.70
plat var snap 5.08

plat var tklc snap 19.14
NOTE: Anything below 50% is OK.
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Step Procedure Details
8. O | TVOE Server iLO: 1. Atthe promptrun:
manually backout Seuee Su — placei
upgrade
2. Navigate to Maintenance->Upgrade.
4| Upgrade Menu '7
Validate Media
E v Upgrade Checks
Initiate Upgrade
HNon Tekelec RPM Management
pt T
[9)
3. Select Reject Upgrade and press Enter to start the reject process.
The following window opens, click Yes to begin the backout.
—| Main Menu l—
Do you really want to reject the upgrade?
The system undergoes a backout. As part of the process the system reboots several
times.
After completing the final reboot, the login prompt is presented. Some of the final
startup output along with an example of the login prompt is shown below:
4. Login as admusr.
CentOS release 6.2 (Final)
Kernel 2.6.32-220.17.1.elb6prerel6.0.0 80.16.0.x86 64 on an x86 64
hostnamel1342210584 login:
9. O | TVOE Server iLO: Log in and run the following:
check server ——
health.
10. O | TVOE Server iLO: Run the following command to check the health of the server:
check server # sudo alarmMgr --alarmStatus
health
If any output is produced, an alarm is present on the system. Contact Oracle for
information about how to proceed.
11. O | Clear browser Clear browser cache to ensure that browser has the latest client-side code loaded. Refer
cache to browser documentation if necessary.
12. O | PM&C GUI Login to the PM&C GUI to verify the old PM&C version

---End of Procedure---
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APPENDIX C. CORRECTING SERVER CORE FILE DETECTED ALARMS

After the upgrades, if old core file detected alarms are generated, this procedure corrects these alarms.

This procedure is performed during a maintenance window.

Check off (V) each step as it is completed. Boxes have been provided for this purpose under each step

number.

If this procedure fails, contact Oracle Support.

NOTE: this Procedure should take APPROXIMATELY 10 minutes per Blade or RMS server.

Appendix C: Correcting Server Core File Detected Alarms

Step Procedure

Details

CMP GUI: Login into
the CMP GUI using
VIP address as
admin or user with
administrative
privileges

1. []

Login into the PCRF CMP GUI as admin using the VIP IP Address

CMP GUI: Verify
active alarms

In the upper right hand corner of the GUI, click on Minor alarms and check if Server
Core File Detected alarms are present.

orRACLE Oracle Communications Policy Management

Alarm History Report
Start Date End Date Severity Cluster or Server Active Alarms  Aggregate
I = I = Winar Al i - Filter | _Close
11 Alarms found, displaying all Alarms.
Occurrence Severity | Alarm ID Text 0AmM vIP Server
- . oa: — r Core File Detecte wikperfoz-mpe-2a
Feb 09, 2017 07:53 PM GMT-00:00 > 32508 Core File Detected 172.16.22.45 Perfoz-mpe- Y
- X _oa: S— ore File Detecte. wikperfoz-mpe-1b
Feb 09, 2017 07:52 PM GMT-00:00 i 32508 = File Detected 172.16.22.42 Py Y
. _oa: S— ore File Detecte. wikpcrfoz-mra-1b
Feb 09, 2017 07:49 PM GMT-00:00 i 32508 = File Detected 172.16.22.39 B e an 5a Y
= X _oa: inor ore File Detecte. wikperfoz-mpe-2c
Feb 09, 2017 07:49 PM GMT-00:00 Mi 32508 < File Detected B 18 5a FY
X _oa: inor ore File Detecte. wikperfoz-mra-1c
Feb 09, 2017 07:48 PM GMT-00:00 Mi 32508 < File Detected P FY
. . " , westlakelab-mra-1c
Feb 09, 2017 07:47 PM GMT-00:00 Minor 32508 Core File Detected P rY
. _oo: " , westlakelab-mpe-1c
Feb 09, 2017 07:47 PM GMT-00:00 Minor 32508 Core File Detected ST e rY
. _oo: i rver Cor Ikperfoz-mpe-1
Feb 09, 2017 07:46 PM GMT-00:00 Minor 32508 Server Core File Detected B e 1o e Y
. oo: . . rver . o Ikperfoz-mpe-1
Feb 09, 2017 07:46 PM GMT-00:00 Minor 32534 NTP Source Server Is Not Able To Provide Correct Time B e 1o e Y
Feb 09, 2017 07:14 PM GMT-00:00  Minor 32508 Server Core File Detected westikelabimps-2c g4
. _oo: S rver Cor: wikperfoz mpe-1a
Feb 09, 2017 06:10 PM GMT-00:00 Minor 32508 Server Core File Detected 172.16.22.42 P ok

If Server Core File Detected alarms are present, then proceed to the next step,
otherwise stop and there is no need to perform this procedure.

CMP GUI: Note the
server IP addresses
where the Server
Core File Detected
alarm was
generated

Note down the server IP addresses for which Server Core File Detected alarm was
generated.
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Step Procedure Details
4. []| SSH CLI: Login to 1. Login as admusr to each of the noted servers using SSH
gizhv(;ii;:i;::\g:se 2. Change the user to root and change directory to /var/TKLC/core
files are present $ sudo su -
# cd /var/TKLC/core
# 1s
Example:
core.java.9499 core.java.9499.bt
# 1s /var/camiant/cores
Example:
core.java.9499
NOTE: Where 9499 is the java proc_id and is different for each server.
5. []| SSH CLI: cat the Use the cat command on the core.java. <proc_id>.bt file and verify that the core file
core.java.<proc_id>. | was generated by java due to Program terminated with signal 3
bt file # cd /var/TKLC/core
# cat core.java.<proc id>.bt
NOTE: User may need to scroll up
Example below:
[New Thread 9499]
[New Thread 9571]
Core was generated by "/usr/java/jdkl.7.0 72/bin/java -
Djava.util.logging.config.file=/opt/camiant/tom'.
Program terminated with signal 3, Quit.
#0 0x00000039eba0822d in ?? ()
If the reason was due to Program terminated with signal 3, proceed to the next step;
otherwise if the reason was something else then Contact Oracle Support.
6. [_]| SSH CLI: Remove Remove the following files:
zf;iec::‘;ispondmg 1. /var/camiant/cores/corefile.java. <proc_id>
2. /var/TKLC/core/corefile.java. <proc_id>.bt
3. /var/TKLC/core/ corefile.java. <proc_id>
# cd /var/camiant/cores
# rm -rf core.java.<proc id>
# cd /var/TKLC/core
# rm -rf core.java.<proc id>.bt
# rm -rf core.java.<proc id>
# exit
$
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Step Procedure Details
7. []| CMP GUI: Verify On the CMP GUI, verify that the corresponding Server Core File Detected alarms have
alarms been cleared.

---End of Procedure---
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APPENDIX D. ACCESSING THE ORACLE CUSTOMER SUPPORT SITE AND
HOTLINES

Access to the Oracle Customer Support site is restricted to current Oracle customers only. This section
describes how to log into the Oracle Customer Support site and link to Oracle Support Hotlines

1. Loginto the Oracle Customer Support site at https://support.oracle.com

2. Refer Oracle Support Hotlines http://www.oracle.com/us/support/contact/index.html and
http://www.oracle.com/us/corporate/acquisitions/tekelec/support/index.html
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